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Notice
While reasonable efforts were made to ensure that the information in this document was complete and accurate 
at the time of printing, LHR Technologies, Inc. can assume no liability for any errors. Changes and corrections 
to the information in this document may be incorporated in future releases.

Documentation Disclaimer
LHR Technologies, Inc. is not responsible for any modifications, additions, or deletions to the original published 
version of this documentation unless such modifications, additions, or deletions were performed by LHR 
Technologies.

Link Disclaimer
LHR Technologies, Inc. is not responsible for the contents or reliability of any linked Web sites referenced 
elsewhere within this Documentation, and LHR Technologies does not necessarily endorse the products, 
services, or information described or offered within them. We cannot guarantee that these links will work all of 
the time and we have no control over the availability of the linked pages.

Copyright
Except where expressly stated otherwise, the Product is protected by copyright and other laws respecting 
proprietary rights. Unauthorized reproduction, transfer, and or use can be a criminal, as well as a civil, offense 
under the applicable law.

LHR Technologies Fraud Intervention
If you suspect that you are being victimized by fraud and you need technical assistance or support, call 
Technical Service Center at (713) 473-6572 for the United States and Canada. Suspected security vulnerabilities 
with LHR Technologies Products should be reported to LHR Technologies by using our contact page:  http://
www.carvewright.com/cms/contact-us.

Trademarks
CarveWright™ and the CompuCarve™ logo are registered trademarks of LHR Technologies, Inc. in the United 
States of America and other jurisdictions.  Unless otherwise provided in this document, marks identified by “®,” 
“™” and “SM” are registered marks, trademarks and service marks, respectively, of LHR Technologies, Inc. All 
other trademarks are the property of their respective owners.

Documentation information
For the most current versions of documentation, go to the CarveWright™ downloads web site: http://www.
carvewright.com/cms/downloads).

CarveWright™ Software Designer Support
LHR Technologies, Inc provides indirect and direct services for customer support, report problems or to ask 
questions about CarveWright™ Designer Software.  These services are subject to your support agreement. For 
additional information on support, see the CarveWright™ Web site:   http://www.carvewright.com/cms/contact-
us.
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IMPORTANT:  THIS AGREEMENT (or “EULA”) IS A LEGAL AGREEMENT BETWEEN THE PERSON, 
COMPANY, OR ORGANIZATION THAT HAS LICENSED THIS SOFTWARE (“YOU” OR “CUSTOMER”) 
AND LHR TECHNOLOGIES INC.  BY INSTALLING AND USING THE SOFTWARE, CUSTOMER 
ACCEPTS THE SOFTWARE AND AGREES TO THE TERMS OF THIS AGREEMENT.  READ IT 
CAREFULLY BEFORE COMPLETING THE INSTALLATION PROCESS AND USING THE SOFTWARE.  
BY INSTALLING AND/OR USING THE SOFTWARE, YOU ARE CONFIRMING YOUR ACCEPTANCE 
OF THE SOFTWARE AND AGREEING TO BECOME BOUND BY THE TERMS OF THIS AGREEMENT. 
IF YOU DO NOT AGREE TO BE BOUND BY THESE TERMS, OR DO NOT HAVE AUTHORITY TO 
BIND CUSTOMER TO THESE TERMS, THEN DO NOT INSTALL AND/OR USE THE SOFTWARE AND 
RETURN THE SOFTWARE TO YOUR PLACE OF PURCHASE FOR A REFUND IN ACCORDANCE 
WITH ITS REFUND POLICIES.  THIS EULA SHALL APPLY ONLY TO THE SOFTWARE SUPPLIED 
BY LHR TECHNOLOGIES INC.  HEREWITH REGARDLESS OF WHETHER OTHER SOFTWARE IS 
REFERRED TO OR DESCRIBED HEREIN. 
 
1. License Grants
The licenses granted in this Section 2 are subject to the terms and conditions set forth in this EULA: 

 
(a)  Subject to Section 1(b), you may install and use the Software on two computers; OR install and store 
the Software on a storage device, such as a network server, used only to install the Software on your other 
computers over an internal network, provided you have a license for each separate computer on which the 
Software is installed and run.  Except as otherwise specifically provided in Section 1(b), a license for the 
Software may not be shared, installed or used concurrently on more than two computers.  Except solely for 
purposes of installing the Software on a computer as described above, a license for the Software may not be 
accessed and used via a server or network storage device, including without limitation through Citrix and 
Citrix-type environments.  Subject to the terms and conditions set forth in this EULA, you shall not have 
more than one installation of the Software on any single computer. 
 
(b)  Portable or Home Computer Use for Software.  Subject to the terms and conditions of this Agreement, in 
addition to the copy of the Software permitted in Section 1(a), the primary user of the primary computer on 
which the Software is installed may make one other copy of the Software and install it on either a portable 
computer or a computer located at his or her home for his or her exclusive use, provided that : 

 
(A) the copy of the Software on the portable or home computer (i) is not used at the same time as the 
copy of the Software on the primary computer and (ii) is used by the primary user solely as allowed for 
such version or edition, (B) the copy of the Software on the portable or home computer is not installed or 
used after the time such user is no longer the primary user of the primary computer on which the Software 
is installed.  (C)  You may make one copy of the Software in machine-readable form solely for backup 
purposes. You must reproduce on any such copy all copyright notices and any other proprietary legends on 
the original copy of the Software.  You may not sell or transfer any copy of the Software made for backup 
purposes.  In addition, you may make copies of the End User Product, and the associated Carvewright 
Run-Time, and distribute those copies; provided, however, that (i) the Carvewright Run-Time may not 
be distributed or used other than as bundled with the Output File as part of the End User Product, and 
(ii) you shall require each party to whom the End User Product is distributed to agree that no title to, or 
ownership rights in, the Carvewright Run-Time are transferred and that the End User Product, including the 
Carvewright Run-Time, shall not be reverse compiled or disassembled.
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(c)  You agree that LHR Technologies, Inc. may audit your use of the Software for compliance with these 
terms at any time, upon reasonable notice. In the event that such audit reveals any use of the Software by you 
other than in full compliance with the terms of this Agreement, you shall reimburse LHR Technologies, Inc. 
for all reasonable expenses related to such audit in addition to any other liabilities you may incur as a result of 
such non-compliance. 
 
(d)  Your license rights under this EULA are non-exclusive.  

 
2. License Restrictions

 
(a)  Other than as set forth in Section 1, you may not make or distribute copies of the Software, or 
electronically transfer the Software from one computer to another or over a network. 
 
(b)  You may not alter, merge, modify, adapt or translate the Software, or decompile, reverse engineer, 
disassemble, or otherwise reduce the Software to a human-perceivable form. 
 
(c)  Unless otherwise provided herein, you may not rent, lease, or sublicense the Software. 
 
(d)  Unless otherwise provided herein, you may not modify the Software or create derivative works based 
upon the Software. 
 
(e)  You may not export the Software into any country prohibited by the United States Export Administration 
Act and the regulations thereunder. 
 
(f)  You may receive the Software in more than one medium but you shall only install or use one medium. 
Regardless of the number of media you receive, you may use only the medium that is appropriate for the 
server or computer on which the Software is to be installed. 
 
(g)  You may receive the Software in more than one platform but you shall only install or use one platform. 
 
(h)  You shall not use the Software to develop any product having the same primary function as the Software. 
 
(i) In the event that you fail to comply with this EULA, LHR may terminate the license and you must destroy 
all copies of the Software (with all other rights of both parties and all other provisions of this EULA surviving 
any such termination). 

 
3. Ownership
The foregoing license gives you limited license to use the Software. LHR Technologies, Inc. and its suppliers 
retain all right, title and interest, including all copyright and intellectual property rights, in and to, the Software 
(as an independent work and as an underlying work serving as a basis for any application you may develop),  
and all copies thereof.  All rights not specifically granted in this EULA, including Federal and International 
Copyrights, are reserved by LHR Technologies Inc. and its suppliers.
 
4.  Third Party Software
The Software may contain third party software which requires notices and/or additional terms and conditions.  
By accepting this EULA, you are also accepting the additional terms and conditions, if any, set forth therein.
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WARNING or CAUTION:
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HELPFUL INFORMATION:
Look for this symbol to point out helpful information and hints that will allow maximum 
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Computer System Requirements
Microsoft Windows 2000/Windows XP
• 256MB of RAM (512 MB or greater recommended)
• 150MB of available hard-disk space
• CD-ROM compatible drive
• USB Port
• QuickTime 7 or Windows Media Player 8 software required for multimedia features
• Dial-up internet or phone connection required for product/software activation
• Dial-up internet required for software updates for ver 1.123 or later (Broadband or higher recommended) *
• Graphics card with OpenGL support for GPU-accelerated playback
• Broadband internet connection required for Pattern Depot and other services † ‡

Microsoft Windows Vista/Windows 7
• 512MB of RAM (1024 MB or greater recommended)
• 150MB of available hard-disk space
• CD-ROM compatible drive
• USB Port
• QuickTime 7 or Windows Media Player 8 software required for multimedia features
• Dial-up internet or phone connection required for product/software activation
• Dial-up internet required for software updates for ver 1.123 or later (Broadband or higher recommended) *
• Graphics card with OpenGL support for GPU-accelerated playback
• Broadband internet connection required for Pattern Depot and other services † ‡

Macintosh OS X version 10�4 or later
• 256MB of RAM (512 MB or greater recommended)
• 150MB of available hard-disk space
• CD-ROM compatible drive
• USB Port
• QuickTime 7 or Windows Media Player 8 software required for multimedia features
• Dial-up internet or phone connection required for product/software activation
• Dial-up internet required for software updates for ver 1.123 or later (Broadband or higher recommended) *
• Graphics card with OpenGL support for GPU-accelerated playback
• Broadband internet connection required for Pattern Depot and other services † ‡

* Online services, including, but not limited to, Pattern Depot, Online Store, Forum, Software Updates and 
Support (through e-mail), may not be available in all countries.  These services are only provided in English and 
USD. Availability of services is subject to change. Use of online services is governed by terms and conditions of 
a separate agreement and may be subject to additional fees.
† Additional libraries can be purchased online
‡ A cd with the updated software can be provided at a minimal additional cost to customers with a slow or no 
internet connection.

http://www.carvewright.com/store/pattern.php
http://www.carvewright.com/store/pattern.php
http://www.carvewright.com/store/pattern.php
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Standard Upgrades
Uploading of projects created in the software to the memory card with the usb 
programmer (both included with the machine) a
Vector Tools provide shapes that a bit, a cut path, or a carve region can be 
applied to a
Cut path is a cut all the way through the board. Cut path can only be applied to 
a closed figure or a path whose end points cross the edge of the board. a
Carve Region provides uniform carving within an enclosed vector shape to 
certain depths.  a
A surface is a region with a contoured to it. a
Text Tool easily allows for placement and manipulation of text using the fonts 
currently installed in the computers system fonts folder a
Edge rout is a quick tool to apply a rout on all edges of a board. a
Memory Card File Management through the Flash Manager which allows for 
quick file deletion or formatting of the memory card altogether a
Layout tools to assist with the Project designing process that include but are not 
limited to Flip, Rotate, Mirror, Align, Center, and much more a
Graphics can be in imported from files in JPEG, BMP, or PNG formats. a
Drill Tool a
Created patterns can be imported and exported as PTN files. a
Rout Tool allows a figure to be broken into sections, each one with an 
independently assignable bit or depth profile a
Pattern Editor, a standalone software package that allows for in-depth pattern 
manipulation.  Used primarily with the CarveWright Scanning Probe.* a
Centerline Text, a function that allows for carving down the center of a selected 
text path.  Used for engraving text effects.* a
Trim Tool to trim intersecting line segments a
Additional Purchased Patterns, Pattern Collections and Projects* a
STL Importer allows for importing of STL files into the software* a
DXF Importer allows for importing of 2D DXF files into the software* a

* Can be purchased individually from the online store, www.carvewright.com/store.

CarveWright™ Designer Software Features

http://www.carvewright.com/store
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What is the CarveWright™ Software Designer

The CarveWright™ Designer Software is the graphical user interface used to design projects for the 
CarveWright™/CompuCarve™ Woodworking System.  It was designed to be easily interacted with by users.  
The software applies basic principles and commands used in common programming.  This manual will explain 
the features in the software.  Features not in the basic version of the software will be identified.

The CarveWright™ Designer Software  can be used on both Windows and Mac computers that meet 
minimum system requirements.   Very much like any other graphics editing program, the software allows you 
to create new projects, customize them with intuitive editing tools and libraries of carvings, and then upload the 
file to a memory card that can be carved in the CarveWright™/CompuCarve™ Woodworking System.

Though most illustrations in this manual are Windows based computers, all 
shortcuts will be given for both Windows and Mac computers�  Any significant 
differences in software will be clearly illustrated�
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Chapter 1:  Software Installation
The CarveWright™/CompuCarve™ Woodworking System comes with an installation cd.  The CD contains the 
following:

• CarveWright™ Designer Installer [Windows]
• CarveWright™ Designer Installer [Mac]
• CompuCarve/CarveWright Hardware Manual
• CarveWright Designer Software Manual
• Readme Text (documents changes made in the Software)

Since the installation process varies on different operating systems, the 
installation process will be explained for each one.  First, place your 
installation cd into your computer.  Second, determine which operating 
system you are using on your computer from the following:

• Microsoft® Windows®
• Mac OS® X ver. 10.4 or later

Once you have determined which operating system is being used, use the corresponding installation instructions 
in the following sections.
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Microsoft® Windows®

On Windows Vista and Windows 7, the person installing the software will need 
administrator privileges to complete the installation process�

If the autorun activates the setup function click the ‘Cancel’ button and the ‘Finish’ on the 
screen that follows.  Click the Computer Icon from the Start Menu and find the drive that contains the disc 
icon that represents the CarveWright Designer Installation Disc and right-click the Setup icon.

 A context menu will appear with several options.  Click the option to  “Run as 
Administrator”. (If a prompt displays requesting permission to install the application, click 
“Allow” to continue the installation.) 

The first screen that appears will be 
a screen welcoming to the CarveWright 
Designer Software InstallShield Wizard.  
Click the “Next” button when ready.

This screen allows you to read, understand, 
and accept the license agreement. Read 
through the License Agreement the terms and  
click on the radio button I accept the terms 
in the license agreement if agreed upon.  The 
“Print” button will bring up the Print Dialog 
Screen to print the License Agreement for 
your records.  The “Next” button will not 
be selectable unless the terms are agreed to.  
Click the “Next” button when ready.
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This screen prompts for the Username 
that  will be the default author name for 
projects that are saved to the computer.  The 
Organization field may be left blank. Once 
the desired fields are complete, click the 
“Next” button.

This screen will show the default program 
installation directory.  A CarveWright folder 
will be created in the computer’s Program 
Files’ folder. The “Change” button will allow 
for changing the installation directory.  Click 
the “Next” button when ready.

Changing the installation directory folder is 
only recommended for advanced users. 
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This screen shows what type of installation 
the program will perform. The default 
is Complete, which is the recommended 
installation. Select the Custom radio button 
to install only the minimum required 
features (This option is only recommended 
for advanced computer users). Once the 
appropriate radio button is selected, click the 
“Next” button when ready.

This screen will give a final opportunity to 
make any changes to the options that have 
been chosen to this point in the of installation 
process. If there is any uncertainty, select 
the “Back” button to make any necessary 
changes.  Click the “Install” button when 
ready.
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This screen displays that the installation 
process is complete and prompts whether or 
not to show the readme file.  The Readme 
File will show the current software version 
installed and the major updates/changes that 
have been made to the software/firmware for 
the CarveWright/CompuCarve Woodworking 
Machine.   The system will default to 
showing you the “read me” file once you 
close this box. You can un-select this item if 
you do not wish to see this file. The readme 
file can also be accessed from the Start Menu 
under the CarveWright Menu. Click the 
“Finish” button when ready.

The CarveWright Designer Icon should now appear on your computer desktop. 

For Windows Vista and Windows 7 users, right-click the icon and choose “Run as 
administrator” from the Context Menu.  (If a prompt displays requesting permission to install 
the application, click “Allow” to continue the installation.)   This should only need to be done 
once.  
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Mac OS® X ver. 10.4 or later

The person installing the software will need administrator privileges to complete the 
installation process�

Double-click the disc icon on your desktop that represents the CarveWright installation disc and in the 
CarveWright window, look for the file CarveWright�dmg. Drag the file to the desktop area before attempting to 
install it.  Double-click the file to install disc image.

 The progress bar will indicate at which point the installation is.  The ‘Cancel’ button will stop the process and 
the ‘Skip’ button will move to the next process.

An icon will be placed on the desktop to reflect the Disk Image has been mounted.  
Double clicking the new icon will open the contents of the folder to display the 
CarveWright Designer Software as well as the Readme file which shows the current 
software version installed and the major updates/changes that have been made to the 
software/firmware for the CarveWright/CompuCarve Woodworking Machine
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The applications folder 
is where most of the 
programs on a Mac 

system are kept. It can 
be accessed through 

Macintosh HD (default 
name). 

  

Drag this icon from the 
CarveWright folder to the 
Applications folder or the 
desired file location.
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Chapter 2:  Software Activation

Any version of the software prior to version 1�123 can not 
be registered�

When the software is opened for the first time, a screen will display how many days are remaining to use the 
software without activating.  It is possible to use the software for thirty days, with the exception of uploading 
any projects to the memory card. To use the software without activating the software, select the “Continue 
without Activating” button.  To register the software, select the “Register Now” button.

Registration Information
You will need your Machine Serial Number located at the back of the machine by the power cord as illustrated 
below.
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If you already have an account and do not remember your password, you can retrieve it at 
www�carvewright�com/register with your username and e-mail address listed on the account�  If 
you do not remember the username/e-mail address or do not have access to the e-mail address on 
record then you can contact software support�

Support Contact Information
www.carvewright.com/cms/contact-us

The Machine Serial Number can also be retrieved 
from the options menu on the machine.  From 
the Main Menu, press the “0” key to display 
the Options Menu then the “4” key to display 
the Machine Serial Number.  It will be the same 
number found on the back of the machine.
 

Registration Acknowledgment

In order to access the registration options, all the checkboxes need to be checked.  the checkboxes represent that 
the documentation has either been watched or read.  If this has not been done, do not click the checkboxes.

http://www.carvewright.com/register
http://www.carvewright.com/cms/contact-us
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Registration Options

Activating the software will provide four options, which will be described in the following sections. 
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Register Online

If the computer is connected to the internet, whether it is a dial-up or broadband connection, choose the Register 
Online Now radio button from the Registration dialog box then the next button.  Registering online will advance 
to a screen with two options.  If this is a first time account registration then choose the first option.  

If an account was already created, 
choose the I already have a 
CarveWright customer account radio 
button and the username/password 
for the account.  To have the software 
keep the login information then click 
the check box to Remember Login.  

The software will attempt to connect with the registration server 
and show progress as it connects.
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When creating a new account, the Username has to be unique and all of the required fields indicated by 
(required) have to be filled in.  Ensure that the Machine Serial Number is entered with the letters capitalized 
with decimal in the appropriate places (ex: AX.###.###).

On success, a confirmation will 
display on the screen thanking 
you for registering your machine/
software.  

If an account was already created, and there are additional features on the account, a screen will display them 
with check boxes.  Click the check boxes for the desired features and click the “Next” button to finish the 
process.
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Register using Another Computer Connected to the Internet

From the Registration dialog box choose the second radio button Register at www�CarveWright�com using 
another computer and click the “Next” button. A screen will display the Computer ID number and a field to 
enter a License Code.  The Computer ID and Machine Serial Number will be needed at a computer connected to 
the internet.

On the internet connected computer, open an internet browser and go to www.carvewright.com/register to 
create/login to an account.  Choose Click here to create a new account unless an account was previously 
created, then enter the username and password in login boxes.

When creating a new account, the Username has to be unique and all of the required fields indicated by an 
asterisk (*) have to be filled in.  Ensure that the Machine Serial Number is entered with the letters capitalized 
with decimal in the appropriate places (ex: AX.###.###) .
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The screen that follows will prompt for the Computer ID number given from the software with all letters 
capitalized (ex:  J5Y4-83DV) and click the “Done” button.  If the Computer ID number is valid then another 
screen will prompt for a computer description.  The computer description is for identifying the computer on the 
account should any changes need to be referenced to the particular computer (ex: Home PC or Shop Computer).  
The final screen will show the machine and computer  that were added.  The 18 character License Code is what 
needs to be entered into the software to activate it.  This License Code will only be valid for the Computer ID 
number for which it references.  There is also a link near the bottom of the screen that allows for downloading 
the license file so that it can be transferred to the computer that has the software to activate and open it. 
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I have a License File

For users that have a license (see Import License File on page 169) you have the option of importing license in to 
the software to activate the CarveWright Designer software.  Selecting the “I have License File” option will 
display Open file dialog.  The Open file dialog box will only show license files (*.mpl) or files with the file 
extension mpl.  Navigate to the location of the appropriate license file and click the ‘Open’ button.

The screen may or may not display the License Import Progress screen.  This depends on the amount of items in 
the licesnes file.

The software will display a successful screen, if the process went through, or display an error screen if 
unsuccessful.
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Register over the Phone

To register by phone,  select the last option and click the “Next” button. This option can only be used during 
normal business hours which can be found on the contact page at www�carvewright�com. Once selected, call 
LHR Technologies, Inc. at 713-473-6572  to speak a customer service representative.  Please have the Machine 
Serial Number (ex: AX.###.###), Computer ID number (ex:  J5Y4-83DV), and contact information ready.  If 
an account was already created, notify the customer Service Representative before any other information is 
prompted for.  Once the representative has all of the required information, an 18 digit license code will be given 
to activate the software for that computer. This code must be entered with all capital letters where it applies.  
Once entered, click the “Next” button.

The representative may ask if there is an e-mail address that a license file can be sent to as there may be multiple 
codes that need to be entered and the process may be quicker through use of a license file.  This license will be 
usable on any computer that the Computer ID number was added to the account.  When the file is viewable on 
the computer, simply double-click the file to activate the software.

http://www.carvewright.com
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Computer ID ______________

Description ________________

License Code ______________

Computer ID ______________

Description ________________

License Code ______________

Computer ID ______________

Description ________________

License Code ______________

Computer ID ______________

Description ________________

License Code ______________

Computer ID ______________

Description ________________

License Code ______________

Computer ID ______________

Description ________________

License Code ______________

This section has been provided to record the username and password used to create the 
customer account.  This will be the username and password used within the software or at www.
carvewright.com/register whenever prompted.  Additional space has been provided to record the 
activated computers information.  Computer information is also stored online on the account.

Username ___________________________

Password ___________________________
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Computer ID ______________

Description ________________

License Code ______________

Computer ID ______________

Description ________________

License Code ______________

Computer ID ______________

Description ________________

License Code ______________

Computer ID ______________

Description ________________

License Code ______________

There are two additional online features that can be accessed with an internet connection, the Online Forum 
and the CarveWright Store.  These two features require account logins but are not associated with any other 
accounts.  An Account must be created for each feature.  The same Username can be used for each if they are 
available.  Register for the forum at www.carvewright.com/forum (online community) and the store at www.
carvewright.com/store (purchase items).  Space has been provided to record the Username/Password for each. 

Forum Account

Username ___________________________

Password ___________________________

Store Account

Username ___________________________

Password ___________________________
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Chapter 3:  Software Basics

File Extensions
File extensions are the file names that are associated with the software.  When the software is first loaded, the 
registry is altered so that if the file extensions are activated then the CarveWright Designer Software opens and 
initiates the assigned process.  The file extensions associated with the CarveWright Designer Software are the 
following:

MPC (*.mpc) 
 File extension for pieces (board or Project file) created in the CarveWright Designer Program.

MPL (*.mpl) 
 File extension associated with licenses that can activate software on any computer where the 
Computer ID Number has been added to the customer account.

PTN (*.ptn)  
 File extension associated with patterns that can be imported into the software or manipulated 
with the Pattern Editor (explained in the Upgrades Chapter) provided the computer used is the original 
designer.   

MPW (*.mpw) 
 Artwork files associated with the Pattern Editor.  The Pattern Editor is accessed through the 
CarveWright Designer Software.  File type for “raw” scans when opened in the Pattern Editor.

MPN (*.mpn) 
 The file extension associated pattern libraries.  Pattern Libraries contain the individual patterns 
that are accessible through the software from the Pattern List.

MWM (*.mwm) 
 This file extension interacts with the memory card.  These file types hold the information needed 
to run the machine or firmware.  Use of this is explained in the Import and Upload Chapter.

Topics:
•  File Extensions
•  Software Layout
•  Title Bar
•  Menu Bar
•  Toolbars
•  Workspace
•  Scroll Bars
•  Status Bar
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Software Layout

When the software is first started, it will appear with a menu and toolbars at the top of the window. The different 
aspects of the project window will be explained throughout this chapter.

Figure 3�1�  Screen Layout [Windows]
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Though the MAC and Windows software have the same capabilities and features, the MAC software is laid 
out differently illustrated below.  Notice the Menu Bar is displayed at the top of the Monitor.  The Menu stays 
docked at the top of the screen no matter where the program window is located.  

Figure 3�2�  Screen Layout [Mac]
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Title Bar

The title bar shows the logo, the CarveWright Program name and the file name of the current project in brackets.  
Clicking and dragging this bar will move the window on both Microsoft Windows and Macintosh computers.  
The Title Bar also contains the minimize, maximize and close window button.

Figure 3�3�  Title Bar [Windows]

Figure 3�4�  Title  Bar [Mac]

Minimize
 Windows Button   Mac Button

Click to hide the program window but keep the application running and quickly accessible.  When minimized, 
the program will remain on the task bar but not visible.

 Maximize
Windows Button  Mac Button

Also known as re-size or zoom, maximize is an option available for the open project window in the 
CarveWright Designer Software that allows a user to enlarge a project window to its maximum size, commonly 
the full display area of the monitor or screen, or the program window that contains the window being 
maximized.  When the project window is maximized the screen will be unable to move or re-size until it is in 
window mode.  Another method of Maximizing the project window is double-clicking the title bar.

Close Program
 Windows Button   Mac Button

In general, close is an action performed to terminate a portion of a program or the complete program. If a file is 
being worked on or has changed since it has been opened and the program is closed, it is possible for the work 
done on the project to be lost. 

When referring to a button or a feature in a GUI operating system, the close button allows a user to terminate a 
window within a program or the complete program.

In Microsoft Windows operating systems and many other operating systems and software programs, the close 
button with a “X” is generally located in the top right corner of the window. If there are multiple windows 
opened within the program the “X” at the top right corner will close the program the “X” beneath will close the 
window but keep the program open. 

 Restore Down
This is the “opposite” of the Maximize button as the maximize icon will change to the Restore Down Icon when 
clicked.  Also known as Window Mode, Restore Down makes the project window smaller which can be re-sized 
and moved to any size or position.   The alternate method of placing the project window in Window Mode is 
double-clicking the title bar when maximized.
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Menu Bar

Textual list of menus commonly located beneath the title bar of a window that lists various menus that can be 
selected.  Directly below the title bar is the menu bar, which contains pull-down menus that organize families of 
commands for working with documents.  For example, the File menu contains the command that allows access 
to the memory card.  You can open menus by clicking them or by pressing Alt+underlined letter shown in the 
menu’s name on the menu bar.  Pressing Alt+T, for example, opens the Tools menu.  

Figure 3�5�  Menu Bar
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Toolbars

.

Unavailable Icons

Whether using the keyboard shortcuts or the mouse, some commands are not accessible 
unless certain criteria are met.  These commands will appear gray on the menu or toolbar until 
option is available. 

Example:  Until an item on the project is selected, the EditðCut feature is grayed out. 

Inactive Icon
(Gray)

    

Active Icon
(Color)

Standard Toolbar
The Standard Toolbar is used for quick access to the common features found in most programs such as new file, 
open, and save.  It also contains the most common tools from the edit menu.

Figure 3�6�  Standard Toolbar (Default)

Drawing Toolbar
The Drawing Toolbar is used to select and place most of the vector tools in the software (Rectangle, Circle and 
Line).  The drop down arrows next to the main vector tools allow for the tools to be selected.

Figure 3�7�  Drawing Toolbar (Default)

Carving Toolbar
The Carving Toolbar is used to quickly access the pattern list and the options that can be easily associated with 
such as feathering, bit optimization and draft.

Figure 3�8�  Carving Toolbar (Default)

View Toolbar
The View Toolbar is used to change how the board looks on the screen as well as changing the perspective 
of the board.  The ruler enhancements can be toggled from this toolbar allowing for uncluttered views of the 
board..

Figure 3�9�  View Toolbar (Default)
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Layout Toolbar

The Layout Toolbar is used to quickly set the alignment, centering, standard rotation and mirroring of items on 
the board. Items that are grayed out cannot be used on the selected item or group.

Figure 3�10�  Layout Toolbar (Default)

Tools Toolbar
The Tools Toolbar contains the more commonly used tools that woodworkers are used to.  Some of the tools 
included are the drill tool, edge rout tool and the carve region tool.

Figure 3�11�  Tools Toolbar (Default)

Input Toolbar
The Input Toolbar is used to input dimensions relating to geometry on the board. The input boxes will change 
depending on the type of geometry that is active.

Figure 3�12�  Input Toolbar (Default)

Utility Toolbar
The Utility Toolbar is used to interact with the vector tools of the drawing toolbar.  Lines can be added, 
subtracted from, changed to a spline or even to a radius.  These are the more advanced tools that are discussed 
in Chapter 7: Advanced Drawing Features on page 61.

Figure 3�13�  Utility Toolbar (Default)

For information on customizing the toolbars see Chapter 21: Toolbar Customization on page 175.
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Workspace

The Workspace displays the current board that is being worked on.  The board can be rotated within the 
software to show any items/features that have been applied to a board.  The view of the board will change based 
upon the zoom, dimensions of the board, or rotation of the board but will generally remain the same throughout 
the design process of a board.

Figure 3�14�  Workspace

Scroll Bars
The Scroll Bars are used to move the entire work piece up, down, left and right.  The scroll bars are located 
on the bottom and left of the project window.  The inner sliding bar can be used as a guide to know how much 
room is available for scrolling.

Figure 3�15�  Scroll bar [Windows]

Figure 3�16�  Scroll bar [Mac]
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Status Bar

At the bottom of the Application Window is a status bar. As the mouse is moved over any icon the name of the 
tool or function represented by the icon will appear in the status bar. When the mouse is moved over a board the 
position of the mouse on the board will be displayed in the status bar (See Chapter 5 on this feature).

Figure 3�17�  Status Bar
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Chapter 4:  Quick Start
This chapter is a quick overview of creating a new project and how to use the mouse and keyboard.

Creating a Board
To create a new board, press the New Piece button in the Document Toolbar to launch the New... dialog.

Figure 4�1�  New Piece/Project Dialog

Type the desired dimensions of the piece to create, then click the OK button. Use the units pull-down selector 
to choose between US (Inches) and Metric (Centimeters) measurements.  Fractional measurements may also be 
entered, such as “12 3/4” instead of “12.75”.

Due to Machine restrictions, the minimum size board is 6 inches (15.25 cm) long by 1.75 inches (4.5 cm) wide 
by one half inch (1.25 cm) thick. The maximum board size is 144 inches (366 cm) long by 15 inches (38 cm) 
wide by 5 inches (12.5 cm) thick.  Note:  Smaller board dimensions can be applied but the board will have to be 
placed in a jig or Cut from a larger board when complete.

Once a board is created, it will display in the work window. The next section explains how to manipulate the 
board.

Topics:
•  Creating a Board
•  Using the Mouse
•  Cursor Shapes
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Using the Mouse

When a board is created or opened by means of the New Dialog or by opening a saved file, a window will 
appear in the work area to display the piece. These mouse controls may be used to manipulate it:

Figure 4�2�  Three Button 
Mouse

Figure 4�3�  Single Button 
Mouse

Figure 4�4�  Windows Keyboard (Part) Figure 4�5�  Macintosh Keyboard (Part)

Left Button: Performs the appropriate left-click action for the currently selected tool, as indicated by the 
cursor shape (See Cursor Shapes below). Visit the Tools Quick Reference topic for quick information about the 
available tools�

CTRL + Left Button [z + Click]: Hold the CTRL key down while left-clicking in order to perform the 
alternate function of the currently selected tool. For instance, holding CTRL down will allow for multiple item 
selection while the Pointer Tool is selected.

SHIFT + Left Button: Hold the SHIFT key down, then click and drag in order to zoom the board by dragging it 
down (towards you) or up (away from you).  A board may also be zoomed by means of the Magnifying Glass on 
the View tool bar.

1 to 3 ratio

Most mouses today have a three 
button setup (left, right, and middle).  
However most Macs come with a 
single button mouse (the “middle” 

button on the mouse to the right 
initiates the dashboard which stills make it a 
single button mouse).

This manual is written from the Three 
button mouse perspective.  Single button mouse 
users can use the ‘CTRL’ button + click to get 
right-click functions.  Single button instructions 
are indicated by brackets.  Not all mouse 
functionality from the Three button mouse is 
re-creatable on the Single button mouse.

Apple has a 3 button mouse on the market 
for MAC Users.  Consult your local Apple 
retailer.
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Middle Button [CTRL + z + Click]: Click it and drag to rotate the board.  The board can be rotated without a 
three-button mouse by right-clicking while holding the CTRL key.

Right Button [CTRL + Click]: Clicking the right button will pop-up a menu (context menu) that is context-
sensitive to the mouse cursor’s location. Most settings and configuration items for boards and carvings may be 
found by right-clicking over the item you wish to modify.

CTRL + Right Button: Hold the CTRL key down, then right-click and drag the board to rotate it. The board can 
also be rotated with the middle button, if your mouse is equipped with one.

SHIFT + Right Button [Shift ñ + Click]: Hold the SHIFT key down, then right-click and drag in order to pan 
the board by dragging it up, down, left, or right. The view may also be panned by means of the scrollbars that 
appear when a board is zoomed larger than the window or by selecting the Pan Tool.
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Cursor Shapes

The cursor shape will change based on the key/mouse combination that applies at its current position. Below are 
the various cursor shapes:

 Arrow Pointer:
This default cursor indicates that whatever is under it will be selected, be it a button, carving or a 
board. Left-click and drag on a board to draw a box for selecting multiple items.

Magnifying Glass:
Click to zoom the view into a particular spot. Use the CTRL key to zoom out the view (The Right 
Mouse buton will also zoom out as well when selected).  

Crosshair:
This cursor indicates that a new figure or vertex will be placed onto the board, according to the 
currently selected tool. In most cases, the placement may be canceled by pressing the ESC key or 
clicking the middle or right button on the mouse.

Pointing Hand:
This cursor typically appears over a control point, and indicates that the control point will be 
manipulated when left-clicked and dragged. More information about Control Point may be found in 
the Drawing section.

Movement Arrows:
These arrows indicate that the line, vertex, or figure underneath the cursor will be moved when 
left-clicked and dragged. More information about manipulating figures may be found in the 
Drawing section.

Forbidden:
This indicates that no left-click action is available at the cursor’s location, and is typically seen when 
the currently selected tool does not apply at the mouse location, such as when the cursor is in the 
empty space around a board.

Up Arrow:
This cursor appears while selecting an edge during the placement of a new attachment. More 
information about attachments may be found in the Drawing section.
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Chapter 5:  Board and View Manipulation
This section will illustrate some of the mechanisms for starting a new board, placing objects, and manipulating 
board objects.

Board Texture
Complex carvings or fine details can be difficult to see with the wood grain that normally appears on the board. 
This wood grain can be toggled on and off by selecting Toggle Texture  from the View pull down menu or 
tool bar.

 
Figure 5�1�  Texture On

 
Figure 5�2�  Texture Off

 

Topics:
•  Board Texture
•  Construction Lines
•  Rendering Quality
•  Grid
•  View Settings
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Construction Lines

Construction lines are the horizontal and vertical black dotted center lines that are visible on the surface of the 
board. These lines are used to attach geometry and assist in layout. The construction lines can be toggled on and 
off by selecting Toggle Construction Lines from the View pull down menu or tool bar.

Figure 5�3�  Construction Lines

Rendering Quality
To increase performance, the software normally displays in a lower-quality format while a design is being 
manipulated, and then displays in a high quality format after all manipulation has ceased. This function can be 
can be toggled on and off by selecting Toggle Auto Re-Render from the View pull down menu or tool bar. The 
quality of the rendering can be changed by selecting “Rendering Quality” from the View pull down menu and 
clicking on the desired setting from the drop-down button list of rendering quality settings. Faster machines 
with good graphics cards may be able to turn off auto-render and run at the highest quality setting.

Grid
A grid of lines can be a useful tool for laying out geometry. The grid can be toggled on or off by 
selecting ‘Toggle Grid Lines’ from the ‘View’ menu. The interval of the grid can be changed through 
the Snap dialog that is found in the ‘Layout’ menu. (Snap and Grid on page 129)
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The view of the board can be quickly restored to the front, back, Isometric View, or the closest face of the board 
through the view icons found under View menu or through the tool bars.

Show Front of Piece:
Click this button to re-orient the currently displayed piece to its front face.

Show Rear of Piece:
Click this button to re-orient the currently displayed piece to its rear face.

Show Isometric View of Piece: 
Click this button to re-orient the currently displayed piece to an isometric front view. This angle of 
rotation is convenient for viewing three-dimensional carvings.

Square Board: Click this button to re-orient the currently displayed piece to the closest face. This 
function is convenient for working on the ends or edges of the board
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Chapter 6:  Drawing
This section will illustrate the tools and mechanisms for drawing and manipulating drawn objects.

Topics:
•  Control Points
•  Drawing Tools
•  Placing Drawing Elements
•  Connecting Drawing Elements
•  Editing Drawing Elements
•  Line Orientation
•  Intersections
•  Dimensions
•  Setting Attachments
•  Editing Attachments

Control Points
All elements placed on a board may be manipulated through the use of Control Points which appear as small 
color-coded dots. The color-coding denotes the type and function of the Control Point. The Control Points may 
be left-clicked and dragged to manipulate the shape of the drawing element. Right clicking on a Control Point 
opens a menu of options relating to that Control Point.

Figure 6�1�  Example Drawing Element (Vector)

Red Control Point: Red Control Points appear at the endpoints of line segments, arcs, splines, and on 
all closed drawing elements. To stretch or extend a line segment or closed drawing element, click and 
drag on a Red Control Point.

Purple Control Point: Purple Control Points appear only on Splines. To manipulate a spline, click and 
drag on a Purple Control Point.

Teal Control Point: Teal Control Points only appear as extensions on Spline endpoints. To manipulate 
these points, click and drag on a Teal Control Point.

Yellow Control Point: Yellow Control Points indicate the midpoint of a line segments or the center of 
an arc/circle. These points are provided as a convenience for attaching a segment’s center.

Green Control Point: Green Control Points denote the midpoint of arcs. To change the radius of an 
arc, click and drag on a Green Control Point.
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Drawing Tools

Drawing is accomplished by the use of the following tools:

Line Segment Tool: Select this tool, then left-click on the board to begin a line segment. Left-click 
again to end it. You may also click and drag to create a segment.

Connected Lines Tool: Select this tool, then left-click on the board to begin a line segment. Each 
successive left click ends the previous segment and begins a new one. To end the segments, you may 
either double-click to place a final segment, click on the last vertex placed, press the ESC key, or 
click on the first vertex to create a closed loop.

Spline Tool: Select this tool, then left-click on the board to begin a curved segment. Each successive 
left click ends the previous segment and begins a new one. You need to create two or more 
connected segments to see the curve effect. To end the segments, you may either double-click to 
place a final segment, click on the last vertex placed, press the ESC key, or click on the first vertex to 
create a closed loop.

Square Tool: Select this tool, then left-click on the board to start a square, and then left-click again 
to end it. You may also click and drag to create a square. Squares will maintain their square aspect 
when manipulated.

Rectangle Tool: Select this tool, then left-click on the board to start a rectangle, and then left-click 
again to end it. You may also click and drag to create a rectangle.

Circle Tool: Select this tool, then left-click on the board to place the center of the circle, then left-
click again to end it. You may also click and drag to create a circle. Circles will maintain their 
circular aspect when manipulated.

Oval Tool: Select this tool, then left-click on the board to place the center of the oval, then left-click 
again to end it. You may also click and drag to create an oval.

Arc Tool: Select this tool, then left-click on the board to place one end of the arc, then left-click to 
place the other end. You may also click and drag to create an arc. Either way you need to click and 
drag the Green Control Point to change the radius of the arch. 

Spiral Tool: Select this tool, then left-click to place a spiral. It may then be manipulated by dragging 
the yellow border to widen the loops or by dragging its vertices to set the starting and ending loops.

Sine Tool: Select this tool, then left-click to place a sine wave. It may then be manipulated by 
dragging the yellow border to widen or lengthen the loops. You may also click and drag its vertices 
to set the starting and ending loops
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Placing Drawing Elements

To place a drawing element onto the board, click the desired drawing tool from the toolbars and then left-click 
a position on the board to begin placing the drawing element. Some tools, like the pattern and pre-defined curve 
tools, place the drawing element with a single click. Other tools, like the line segment and the shape tools, 
require one or more clicks to place the various vertex locations of the drawing element. 

When a drawing element is first placed onto the board, it is displayed in its selected state as a solid white line 
bounded by a set of Control Points. Control Points may be individually manipulated, or the entire drawing 
element may be moved by left-clicking on the solid white line or within the bounds of a closed drawing element 
and dragging. Right clicking anywhere else on the board or off the board will un-select the drawing element. In 
the un-selected drawing state the drawing element will appear as a black dotted line.

A different drawing element may be selected by clicking its carved area or its black dotted line. If the drawing 
element lay wholly within the area of a currently selected drawing element, then the currently selected drawing 
element may need to be deselected first. The selected state of a drawing element may be toggled by holding 
down the CTRL (z) key while clicking on the drawing element, or all drawing elements may be deselected by 
clicking off the board or by selecting “Deselect All” from the right-click context menu.

Pre-defined curves such as spirals and sine waves display with a yellow box around them. The edges of the 
box may be dragged to expand or contract the drawing element, and the Red Control Point may be dragged to 
extend the number of loops.

Figure 6�2�  Spiral
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Connecting Drawing Elements

Drawing elements can be connected together by dragging the endpoint of one drawing element onto the 
endpoint of another active element. Both elements must be active (white lines) in order to connect the drawing 
elements together (Figure 6�3�1). When an endpoint is over another during a drag, highlights will appear to 
indicate that a connection will take place if the vertex is dropped there (Figure 6�3�2). Connected drawing 
elements will behave like a single drawing element (Figure 6�3�3 & Figure 6�3�4).

1   2   3   4
Figure 6�3�  Connecting Drawing Elements Illustration

Dimensions
When any drawing element is active, Blue numbers will appear indicating the dimensions of the object (radii of 
arcs, lengths of lines). With line segments, green numbers will appear next to a green arc indicating the angle of 
the line segment or the angle between two line segments.

Figure 6�4�  Dimension Example

If a single drawing element is active on the board its dimensions can be changed through the “Input Tool Bar”. 
The input boxes in this tool bar will change depending on the type of drawing element that is active. When more 
than one element is active, it is not possible to enter values through “Input Tool Bar”.

To change a dimension, left click the dimension to open a pop-up box, enter the desired value and press 
enter. If the dimension is left clicked by accident press “Escape” to close the pop-up without entering a value. 
Dimension can also be changed through the context menu, by right clinking and selecting “Edit Dimension”. 
Once a dimension has been set it will turn yellow and become locked or fixed. The dimension will remain fixed 
until a new value has been entered or it is unlocked. To unlock a dimension, left click on it and select ‘Remove 
Constraint’ from the context menu.
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Setting Attachments

Attachments provide the ability to constrain a drawing element or pattern vertices to certain distances from 
board edges and center lines, allowing exact placement of carvings on the board. Once an attachment is placed, 
the carving will be constrained to that distance during any future manipulation.

When any drawing element is placed onto a board, green horizontal and vertical advisory attachment labels will 
be drawn to show the closest attachment points (Figure 6�9). These advisory attachment labels are informational 
only, and serve to aid placement as well as to provide quick means to set attachments.

Figure 6�5�  Advisory Attachment Labels

There are two ways to create an attachment. First, you may click on one of the green advisory attachment 
labels and enter a value. Second, you may right-click any attachable vertex, choose the “Attach” option from its 
context menu, move the mouse close to the edge you wish to attach to until the yellow label is pointing to the 
desired attachment point (Figure 6�10), then left-click to place and set the distance.

Figure 6�6�  An Example Attachment

Once an attachment is placed, it is displayed as a yellow label indicating that it is now a fixed value constraining 
the position of the carving. Attachment labels may be hidden by deselecting the View Labels  option 
through the View pull down or View tool bar.



58

Chapter 6:  Drawing
Editing Attachments

After an attachment is set, the carving will remain constrained to the indicated distance during any further 
manipulation. The attachment may be edited by left-clicking its label and entering a new value, or deleted by 
right-clicking its label and choosing the ‘Remove Attachment’ option from the context menu.

Figure 6�7�  Attachment Context Menu
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Chapter 7:  Advanced Drawing Features
This chapter will illustrate the advanced tools and mechanisms for drawing and manipulating drawn objects.  
The features in this chapter are not for novice users and are only applicable to vector drawings, not raster 
images.  

Editing Drawing Elements
When a drawing element is selected, right-click on the path of the drawing element to open a context menu.

Figure 7�1�  

Select “Insert Vertex” from the context menu to turn the drawing element into two separate but connected 
drawing elements. The intersection point of the elements will appear at the location selected.

Select “Break Figure” from the context menu to turn the drawing element into two separate, unconnected 
drawing elements. The end points of the elements will appear at the location selected.

Select “Form” from context menu and a sub-menu will appear showing line, arc, spiral and sine wave. Simply 
select the desired form to change the segments form.

Topics:
•  Editing Drawing Elements
•  Line Orientation
•  Intersections
•  Rout Tool
•  Utility Toolbar
•  Vertex Tools
•  Change Shape Tools
•  Position Tools
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Line Orientation

Lines can be set to Horizontal, Vertical or Angle by selecting “Orientation” and then by selecting the desired 
setting from the sub-menu. Angle will create a green angle attachment on the line.

Figure 7�2�  Orientation Context Menu

Intersections
Right-click any control point to pop-up a context menu of options specific to that control point. Select 
“Attach” to attach the control point to a fixed distance from a board edge or center line as explained in Setting 
Attachments. Select “Remove” to remove the control point from the drawing element.

Figure 7�3�  Intersection Context Menu

Select “Intersect” to open a sub-menu to choose the form of intersection. The intersection forms are “Normal”. 
Spline” and “Tangent”.  Tangent only applies to intersections with an arc.

Figure 7�4�  Intersect Context Menu
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Rout Tool

The Rout Tool allows a figure to be broken into a number of sections, each one with an 
independently assignable bit or depth profile. Select the Rout Tool  from the Tools toolbar, and then 
select one of the figures on the board.

Figure 7�5�  A Sectioned Figure

When selected, a figure will display as a solid white line, possibly with one or more green sectional vertices. 
You may right-click on a portion of the line and select “Insert Vertex” from the context menu to insert a new 
green sectional vertex, effectively breaking the figure into two parts. Each part may then be individually chosen 
and assigned a bit or depth profile. 

Figure 7�6�  Rout Tool Context Menu

When a figure that has been sectioned with the Rout Tool it will display with one section a solid white line, 
indicating that it is the currently chosen section, and the remaining sections with a dashed white line. Click on 
any of the dashed sections to select it as the currently chosen section. Clicking the Select Bit  or Select Depth 
Profile  buttons will affect only the currently chosen section.

Certain profiles selected from the Depth Profile will insert their own sectional vertices for controlling the 
midpoint of the carving cut or the start of a leaf. These, too, may be manipulated within the Rout Tool.

Possible Machine Damage

Never try to use a Rout to cut a piece out of a board. The piece can get caught by the 
spinning bit and cause damage to the CarveWright/CompuCarve machine.  Always use 
the Cut Path option to avoid this type of damage.
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Utility Toolbar

The utility toolbar is not shown by default but can be made visible by selecting it from the View ð Toolbars ð 
Utility Toolbar.  The utility toolbar provides quick tools for vector drawings that can change the shape and look 
of drawing altogether.

Figure 7�7�  Utility Toolbar

Unlike the other tools, any of the tools selected on the Utility toolbar will not revert to the pointer tool after use.

Vertex Tools
The vertex tools quickly allow for changing of the lines.  These tools only apply to the red points and the line.  
Clicking any other control points will do nothing.   Generally associated with the red points of a line.

AddVertex Tool
The AddVertex icon adds a new vertex point to the vector line.

The example vector has 7 points of 
articulation but there needs to be 8.  
Selecting the AddVertex tool will 
add another vertex where ever you 
choose.  

Clicking on the desired location for 
the new vertex produces the con-
trol point that can be moved where 
desired.

 

The point has been moved, without 
having to create a completely new 
vector for eighth vertex.

Figure 7�8�  Example of AddVertex Tool use
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RemoveVertex Tool
The RemoveVertex icon takes away a vertex point from the vector line.

Clicking the unwanted vertex will 
make the software recalculate the 
line drawing to complete the shape...

      

...by connecting the two control 
points completing the shape.

  
Figure 7�9�  Example of RemoveVertex Tool use

Break Tool
The Break Tool icon splits a line.  The Break Tool splits the vector leaving the remainder of the 
vector intact.  The split goes in the directionality of the created vector.  In the example below, the 
line was created from left to right.  The line when split selected the new point back to the original 

point.

Figure 7�10�  Example use of the Break Tool

Using the break Tool on a circle can have adverse consequences.  It is not suggested to use the break Tool on a 
circle.  Use at your own risk.
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Change Shape Tools

The change shape tools change the function of a vector from just a line to an arc or spline and vice versa.

Change to Spline Tool
The Change to Spline Tool changes a red control point to a purple control point by clicking directly 
on the red control point.  The purple spline point must fall between two red endpoints to see results.

Figure 7�11�  Example Use of the Make Spline Tool

Change to Arc Tool
The Change to Arc Tool changes the yellow control point between two red control points to a green 
control point.  This change makes a regular line into an arc by clicking directly on the line itself.  
The green point can then be moved to define the radius of the arc.

Figure 7�12�  Example Use of the Make Spline Tool

Change to Line Tool
The Change to Line Tool changes  an arc (green control point) or spline (purple control point) to a 
line segment (yellow control point) between two red control points.  Moving the yellow point will 
move the entire line without changing the angle, rotation or endpoints.
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Position Tools

Attach Tool
Attachments provide the ability to constrain a drawing element or pattern vertices to certain 
distances from board edges and center lines, allowing exact placement of carvings on the board as 
stated in the Drawing Chapter.  The Attach tool is a quick icon tool for setting attachments without 
having to right-click on each position for a desired attachment point.

RemoveAttach Tool
The Remove Attach Tool removes the selected attachment point from the board.  Click directly on 
the constrained numbers to remove the attachment from the board.  This can also be accomplished 
by right clicking on the constrained numbers and choosing ‘Remove Attachment’ from the context 
menu.



68

Chapter 7:  Advanced Drawing Features



69

CarveWright Designer Software Manual

Chapter 8:  Inputs
This section will illustrate the tools and mechanisms for drawing and manipulating drawn objects.

Input Toolbar
The input toolbar (Figure 8.1) is the only toolbar that allows for keyboard input directly into the toolbar.   
Whether a pattern or vector shape, the input toolbar is used to make changes to the measurements of a single 
item.  These measurements can be entered as decimals or as fractions (example: 6.125 or 6 1/4).  For more 
information on decimals and the fraction conversions, see the sidebar on Common Decimal Conversions below.

Figure 8�1�  Input Toolbar

Each input field will be explained within this chapter and how it corresponds to certain items.  This toolbar is 
enabled to be viewed by default and can be turned on/off though it is not recommended to turn off.

Common Decimal Conversions

This a table of the most common conversions from decimal to fractions.  When placing a 
fraction with a whole number, there needs to a space placed in between the two. For example:

6 1/16 will be entered as 6 (space) 1/16

Conversion Table
.062 1/16 .562 9/16
.125 1/8 .625 5/8
.187 3/16 .687 11/16
.250 1/4 .750 3/4
.312 5/16 .812 13/16
.375 3/8 .875 7/8
.437 7/16 .937 15/16
.500 1/2 1.00 1

    
For a more extensive list of decimals and their fractional conversions, see Appendix C: Decimal 

Equivalents to Fractional Inches on page 199.

Topics:
•  Input Toolbar
•  Depth
•  Height
•  Angle
•  Radius
•  Inset
•  Length
•  Size
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Depth

The depth parameter is the difference from the top of the board surface to the bottom of the pattern or region. 
(Figure 8.2)  Most Patterns will default to .250 inch depth when placed on the board. The depth can not be set to 
any thickness beyond .800 or the maximum length of the currently selected bit.  If the bit is changed and depth  
exceeds the maximum length of the bit, the depth will automatically change to compensate for the bit.

Figure 8�2�  Depth and Board Thickness

Height
The height parameter is the rise of the pattern up to the surface of the board. No pattern can be carved above 
the surface of the board so the pattern’s height is automatically scaled to avoid this. The height parameter is 
unit-less, meaning it does not have a unit of measure associated with it.  A height setting of 100 means that the 
pattern will be carved at the maximum possible amount of its default height without going above the board. A 
height setting of 200 means that the pattern will be carved at the maximum possible amount of twice its default 
height. Height setting can be set to 0 - 999.

Figure 8�3�  Height Illustration - 0 Height

Figure 8�4�  Pattern - 0 Height   

Figure 8�5�  Height Illustration - 100 Height

Figure 8�6�  Pattern - 100 Height

The default height for a patterns is 100 (Figure 8.5 & Figure 8.6).  If that height were changed to 0, then all 
rises for that pattern are reduced to a point where none of the pattern is seen (Figure 8.3 & Figure 8.4).  When 
the height for a pattern is increased beyond 100, it changes the highest point of a pattern where it closer to the 
surface of the board.  This can improve the detail of a pattern but can also decrease the durability while carving.  
Notice that there is more definition from a height of 100 (Figure 8.5 & Figure 8.6) to a height of 800 (Figure 8.7 
& Figure 8.8).
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Figure 8�7�  Height Illustration - 800 Height

Figure 8�8�  Pattern - 800 Height

Angle

Transforming Input Boxes

The input fields will actually change based on the item selected on the board whereas other 
icons will simply not be available.  These are referred to as “Context Specific” meaning that 
certain actions will occur based on the context or item selected. 
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Figure 8�9�  Input Toolbar (Radius Input Variation)

Radius
In order to understand the Radius input, two words must be referenced, Diameter and Radius.  Diameter is 
defined as a straight line running from one side of a circle or other rounded geometric figure through the center 
to the other side.  Radius is defined as a straight line extending from the center of a circle to its edge or from the 
center of a sphere to its surface.

Diameter = 2 x Radius

Note:  The radius input is only applicable to the Circle tool and the Arc tool.  The radius 
input field will be viewable but unavailable for the Oval tool.

Figure 8�10�  Circle Illustration
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Inset

Inset (and the opposite, Offset) allow for cutting along the path inside or outside the path (Figure 8.11).  This is 
used in conjunction with the select bit icon.  Every bit has a maximum range for the inset value which will vary 
based on the bit selected.  The maximum Offset will be the negative value of the Maximum Inset.  

Example:
Maximum Inset = 0.125 / Maximum Offset = -0.125

Positive values move the bit inside the path of the line (Inset) and Negative values move the bit outside the path 
of the line (Offset).  Use the chart located in the Bits Chapter (Bits on page 77) in order to see the maximum bit 
inset per bit.

Figure 8�11�  Inset and Offset Illustration
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Figure 8�12�  Input Toolbar (Length Input Variation)

Length
The length parameter (Figure 8.12) is the difference from one end point to the other end point and is only 
applicable to the lines that have two end points (Figure 8.13).  If more than one line is selected then the length 
parameter will not be selectable.  If there is curvature to the line in anyway or has a green dot on the center then 
the length will not be accessible because it is an arc and not a line.

Figure 8�13�  Line & Length Illustration
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Size

The size input field refers to the bounding box for both patterns and vector shapes.  Any changes made on the 
screen immediately reflect in the size input box.  

Figure 8�14�  Input Toolbar - Size

The bounding box most times will be the yellow dashed line with triangles at each corner or mid points in 
between the corners.  However, there are times when the bounding box will not be shown such as the case with 
vector drawings.  If there is no visible bounding box, then the implied bounding will be adjusted.

  
Figure 8�15�  Size Bounding Box Examples

In the example above, the bounding box is not visible but the size input box is still applicable.  For the 
illustration, two circles have been placed on top of each other and selected to show that the bounding box 
principles are still present even though they may not be seen.
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Chapter 9:  Bits & Bit Features
This chapter will illustrate the bits and bit tools for use in the CarveWright Designer Software.

Bits
Before getting to how to use the various features for bits, it is a good idea to familiarize with the bits that are 
available in the software.  The information for the various bits is described below with an illustration of the bit.  
Some bits may be referred to by multiple names and the references are indicated in parentehsis.  This list of bits 
is the approved bits that are selectable in the software.

1/16” Tapered Carving (1/16” Carving Bit; 1/16” Ballnose)
SKU Number: Shank Size:

BCR062 1/4”
Maximum Cut Depth: Recomm. Max Pass:

0.800 0.125
+/- Inset: Recomm. Rout Depth:

0.031 N/A
Special Notes:

The 1/16” carving bit is the default bit for raster images in the software.  This is the “workhorse” bit that is 
used a majority of the time for carvings.

1/8” Straight Cutting (1/8” Cutting Bit)
SKU Number: Shank Size:

BCT125 1/4”
Maximum Cut Depth: Recomm. Max Pass:

0.800 0.800
+/- Inset: Recomm. Rout Depth:

0.063 N/A
Special Notes:

The 1/16” cutting bit is the default bit for cut paths on the board.  The Cut Path tool explained later in this 
chapter will explian more.

Topics:
•  Bits
•  Routing
•  Selecting the Pattern Bit
•  Bit Optimization
•  Drill Tool
•  Edge Rout
•  Depth Profile
•  Cut Path
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60o V-Groove
SKU Number: Shank Size:

BCT125 1/4”
Maximum Cut Depth: Recomm. Max Pass:

0.438 0.438
+/- Inset: Recomm. Rout Depth:

0.250 N/A
Special Notes:

This bit is used mostly for centerline text carving.

90o V-Groove
SKU Number: Shank Size:

BVG90 1/4”
Maximum Cut Depth: Recomm. Max Pass:

0.375 0.375
+/- Inset: Recomm. Rout Depth:

0.375 N/A
Special Notes:

This bit is used mostly for centerline text carving.

3/8” Straight (Jointing)
SKU Number: Shank Size:

J0002 1/2”
Maximum Cut Depth: Recomm. Max Pass:

0.800 0.250
+/- Inset: Recomm. Rout Depth:

0.188 N/A
Special Notes:

1/4” Round-Over
SKU Number: Shank Size:

BRD25 1/2”
Maximum Cut Depth: Recomm. Max Pass:

0.375 0.375
+/- Inset: Recomm. Rout Depth:

0.375 0.375
Special Notes:

This bit is a profile bit used for routing the edge of the board.
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1/2” Round-Over
SKU Number: Shank Size:

BRD50 1/2”
Maximum Cut Depth: Recomm. Max Pass:

0.750 0.400
+/- Inset: Recomm. Rout Depth:

0.690 0.690
Special Notes:

This bit is a profile bit used for routing the edge of the board.

1/8” Roman Ogee
SKU Number: Shank Size:

BRO125 1/4”
Maximum Cut Depth: Recomm. Max Pass:

0.438 0.438
+/- Inset: Recomm. Rout Depth:

0.405 0.350
Special Notes:

This bit is a profile bit used for routing the edge of the board.

3/16” Roman Ogee
SKU Number: Shank Size:

BRO188 1/2”
Maximum Cut Depth: Recomm. Max Pass:

0.500 0.260
+/- Inset: Recomm. Rout Depth:

0.500 0.450
Special Notes:

This bit is a profile bit used for routing the edge of the board.

1/8” Ball Nose
SKU Number: Shank Size:

BBN125 1/4”
Maximum Cut Depth: Recomm. Max Pass:

0.800 0.800
+/- Inset: Recomm. Rout Depth:

0.063 N/A
Special Notes:
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1/4” Ball Nose
SKU Number: Shank Size:

BBN25 1/4”
Maximum Cut Depth: Recomm. Max Pass:

0.800 0.250
+/- Inset: Recomm. Rout Depth:

0.125 0.250
Special Notes:

1/2” Ball Nose
SKU Number: Shank Size:

BBN50 1/4”
Maximum Cut Depth: Recomm. Max Pass:

0.625 0.250
+/- Inset: Recomm. Rout Depth:

0.245 0.250
Special Notes:

This bit is a profile bit used for routing the edge of the board.

3/8” Classical Ogee
SKU Number: Shank Size:

BCO375 1/4”
Maximum Cut Depth: Recomm. Max Pass:

0.438 0.438
+/- Inset: Recomm. Rout Depth:

0.375 0.375
Special Notes:

This bit is a profile bit used for routing the edge of the board.

1/2” Classical Ogee
SKU Number: Shank Size:

BCO50 1/2”
Maximum Cut Depth: Recomm. Max Pass:

0.625 0.290
+/- Inset: Recomm. Rout Depth:

0.500 0.500
Special Notes:

This bit is a profile bit used for routing the edge of the board.
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1/16” Cutting Bit
SKU Number: Shank Size:

BCT062 1/4”
Maximum Cut Depth: Recomm. Max Pass:

0.250 0.125
+/- Inset: Recomm. Rout Depth:

0.031 N/A
Special Notes:

3/16” Carving Bit
SKU Number: Shank Size:

BCR187 1/2”
Maximum Cut Depth: Recomm. Max Pass:

1.000 0.290
+/- Inset: Recomm. Rout Depth:

0.125 N/A
Special Notes:

This bit can only be purchased with the CarveTight Adapter.

3/16” Cutting Bit
SKU Number: Shank Size:

BCT187 1/2”
Maximum Cut Depth: Recomm. Max Pass:

1.100 0.800
+/- Inset: Recomm. Rout Depth:

0.125 N/A
Special Notes:

This bit can only be purchased with the CarveTight Adapter.
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Routing

Routing is applying a bit to a path at a set depth. This function can be done on any drawing element or outline. 
To create a rout, select the desired geometry then press the Select Bit button from the Tools pull down menu or 
the Tools toolbar. A dialog will open showing all of the bits available.

Figure 9�1�  Select Bit Dialog

Select the desired bit, enter the desired depth and press ‘OK’ to apply the bit. The default depth varies by bit. 
Once a rout has been applied the depth may be changed in the Depth Entry Box on the Input Toolbar. To change 
the bit press the Select Bit button and select the bit. The “No Bit” button may be pressed to deselect any bit 
which will tyrn the input and depth boxes red indicating invalid values.  Clicking the ‘No Bit’ button will revert 
the selected figure back to a dotted path.

Possible Machine Damage

Warning! Never try to use a Rout to cut a piece out of a board. The piece can get 
caught by the spinning bit and cause damage to the CarveWright/CompuCarve 
machine.  Use the Cut Path option explained later in this chapter or jig if rout cut 
through can not be avoided.
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Selecting the Pattern Bit

Every pattern on a board is carved using the same bit, generally a 1/8 or 1/16 inch fine detail bit. The bit used to 
carve patterns on the board may be set through the Board Settings dialog.  The Board Settings can be accessed 
by going to the ‘Edit’ menu and selecting ‘Board Settings’.  ‘Select Pattern Bit’ option is on the ‘Pattern Bit’ tab.  
The ‘OK’ button will confirm the selection and the ‘Cancel’ button will close the Board Settings dialog without 
making any changes.

Figure 9�2�  Board Settings Dialog

Bit Optimization
A finely detailed pattern may be distorted due to the width of the router bit cutting away more than is desired 
while carving the pattern. Bit optimization provides a method to solve this problem. With bit optimization 
enabled, the pattern is modified in order to minimize the amount of the pattern that will be lost due to the size of 
the bit.

To enable bit optimization, select ‘Bit Optimization’ from the ‘Carving’ menu, Carving toolbar or context menu, 
and then select the desired bit optimization level from the ‘Bit Optimization’ sub-menu.

Figure 9�3�  Bit Optimization Icon

Bit optimization may require a considerable amount of processor time. Waiting to turn on bit 
optimization until initial layout is complete can help speed up project design.
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Drill Tool

The drill tool provides a quick way to create holes. To create a hole select the drill tool from the tools pull down 
menu or toolbar. Then left click the point on the board where you want the hole and a dialog will open. Enter 
the diameter of the hole and then select “Through the Board” or press the button to enter a depth.

Figure 9�4�  Drill Tool 
icon

Figure 9�5�  Drill Tool Dialog

Once a hole has been applied the diameter may be changed in the diameter Entry Box on the Input Toolbar. If 
the hole was not through the board the depth can be changed in the Depth Entry Box on the Input Toolbar. The 
position of the hole can be manipulated in the same way as other patterns.

Edge Rout
Edge Rout is a quick tool to apply a rout on all edges of a board. It is not possible to pick and choose which 
sides will have the rout applied to it or not.  To apply an edge rout select ‘Edge Rout’ from the ‘Tools’ menu or 
Tools toolbar.  

Figure 9�6�  Edge Rout icon

The Select Bit dialog will open showing the profile tab of the bits available (Figure 9.1). Select the desired 
bit, depth and wether if it is going to be a single/multi-pass routing.  Pressing the ‘OK’ button will confirm all 
choices selected and the ‘Cancel’ button will close the Select Bit dialog without saving any of the choices made.

Close to the Edge

Full board edge routs will cause the workpiece to lose contact with the Board 
Tracking Sensor on the CarveWright/CompuCarve Woodworking Machine.  It is 
recommended that the projects with edge routs be placed in a jig or auto-jigged.  See 
Chapter on Uploading for more information.
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Depth Profile

A Depth Profile may be applied to a figure in order to produce an effect similar to a hand-applied carving stroke. 
Select the desired elements on the board then press the Select Depth Profile button in the Carving Toolbar. A 
dialog will open showing the available profiles. The profiles on the left are created with a haft inch V bit. The 
profiles on the right are created with a haft inch ball nose. Reverse cut changes the direction of the cut. The 
depth input is the depth at the deepest point and the max depth that can be set is .5 inches. Select the desired 
profile, enter a depth and press OK.

Figure 9�7�  Select Depth Profile Dialog

Once a profile has been applied the depth may be changed in the Depth Entry Box on the Input Toolbar. If you 
chose a Depth Profile that is not symmetric, and the resulting cut appears in the opposite direction than what 
you desired, you may select the ‘Reverse Cut’ option from the ‘Tools’ toolbar or right-clck and choose the 
option from the context menu.

Any Depth Profile with a midpoint or leaf will insert a special sectional vertex controlling its location which is 
editable by means of the Rout tool.
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Cut Path

Cut path is a cut all the way through the board  that will leave small tabs holding the cutouts in place so multiple 
pieces can be laid out and cut from a single board.  The board on the computer will not display the tabs so that 
the final product may be seen on-screen. Cut Path can only be applied to a closed vector or a path whose end 
points cross the edge of the board.  To create a cut select the desired geometry then press the ‘Cut Path’ button 
from the ‘Tools’ menu or the Tools toolbar.  The Cut-Out Control dialog will open.

Figure 9�8�  Cut Path Icon

Figure 9�9�  Cut-Out Control Dialog

Cutting Bit
The Cut-Out Control Cutting Bit may be changed from the default 1/8” Cutting Bit to the 1/16” Cutting Bit.  If 
the board thickness is beyond the maximum cut depth of the 1/16” Cutting Bit (0.250 in) then the ‘Accept’ will 
become unavailable with a warning ‘Board Too Thick’.

Tabs
The tabs are calculated by the machine and as stated above will not show on-screen, but the minimum amount 
of tabs, spacing and height can be defined from the Cut-Out Control dialog.  The ‘Minimum number of tabs’ 
default is 3 but can be changed from none to 7.  This setting tells the project no matter how big or small it is, 
always have at least this number of tabs to hold the piece in place.

The ‘Tab spacing’ option sets how far apart the tabs from each other.  For example, with ‘1 Tab/Foot’ (default), 
a tab will be placed with 12” in -between before the next tab is placed.

The last option that can be set is the ‘Tab height’ option.  The tab height is how thick the tab will be after 
cutting.  The thicker the tab is the more stable it will be when holding the cut-out piece in place.  However the 
thicker the tab is , the harder it will be to get the piece out.  The default for this setting is 1/8”.
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Retain Tab Settings

The two check boxes that are available will maintain the choices made in the tab settings for future use of the 
Cut-Out Control.  The first check box ‘Make default for this project’ tells the software for every new instance of 
the Cut Path that is placed on the board within the same project, use the tab settings selected.  The second check 
box ‘Make default for new projects’ tells the software to use the tab settings every time the Cut-Out control 
dialog is opened.

Cut-Out Settings (Inset)
Inset is the amount inside or outside the path the bit will be applied.  The Inset can be entered here in a positive 
or negative number.  

Board Surface

+ Inset - Inset

Side View

Top View

Figure 9�10�  Inset Illustration
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Cut Out Settings (Max Pass Depth)

The ‘Maximum Pass Depth’ allows for changing from a single cut pass to multiple cut passes.  The default 
setting is a single cut pass (check box unchecked) where the machine cuts out the piece in one single pass.  If 
it is desired to have multiple passes, check the check box and define the maximum pass depth.  This tells the 
machine to carve so deep on each pass before starting the next pass.  For example, a 1/4” pass depth on a 1” 
board will take at least 4 passes to cut the piece away from the rest of the board.

Board Surface

Side View

Single Pass Depth Max Pass Depth

Figure 9�11�  Single Pass vs Max Pass Depth

Bit Longevity Preparedness

Warning! Multiple passes may be required for very hard woods or for plastics.

Edit Cut-Out Settings
Once the Cut-Out Control has been accepted, clicking the Cut Path Icon will disable the Cut Path on the screen 
instead of bringing the Cut-Out Control dialog back on the screen.  In order to view the Cut-Out Control for 
a vector with a cut path, the ‘Edit Cut Path’ icon will have to be selected.  This icon will bring the Cut-Out 
Control dialog back on the screen with all the previous selections made.

Figure 9�12�  Edit Cut Path icon

Flip Cut
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The ‘Flip Cut’ button switches the side of the line the cut is to be performed on.  Because the bits have different 
radii, the bits path is placed inside or outside the vector defining what is “scrap” and what isn’t.  It plays a large 
role in the hide cut-out function.  The Flip Cut option can also be accessed from the ‘Tools’ menu or Tools 
toolbar.

Figure 9�13�  Flip Cutout icon

Hide CutOut
Hide cutout eliminates (hides) the portion of the board the cut is performed on (“scrap” or throw-away).  Hide 
Cutout can be toggled on and off by selecting the ‘Hide Cutout’ icon from the ‘Tools’ menu or the Tools toolbar.

Figure 9�14�  Hide Cutout icon
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Chapter 10:  Using Two Dimensional Geometry
This section will illustrate how to use two dimensional geometry such as drawing elements and Outlines

The features explained in this chapter will use the following shape as an example.  It is an enclosed shape 
meaning that the beginning point 

Figure 10�1�  Closed vector shape example

Regions
A region is a flat depression in the board with the shape of the geometry that created it. Any closed figure or 
pattern may be turned into a region. A figure is closed if it forms a complete loop. Squares, rectangles, circles, 
and ovals are always closed. Other figures are closed when their last endpoint is connected to their first endpoint 
to create a loop.

Figure 10�2�  Carve Region Icon

    
Figure 10�3�  An Example Region

To create a region, select the closed figure or pattern on the board and click the Carve Region in the Tools pull 
down menu, Tools toolbar or from the context menu.

Topics:
•  Regions
•  Surfaces
•  Textures
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Surfaces

A surface is a region with a contour to it. To create a surface, select the closed figure or pattern on the board and 
click the Surface in the Tools pull down menu, Tools toolbar or from the context menu

Figure 10�4�  Select Surface Icon

A dialog window will open showing the surfaces that are available. Click on the desired surface and a three-
dimensional view of the surface will appear in the viewing area next to the list. The three-dimensional view 
may be rotated and zoomed with the same mouse controls used for manipulating a board (see Using the Mouse). 
Select the desired surface and click the ‘OK’ button. 

Figure 10�5�  Select Surfaces Dialog
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Like patterns surfaces have both a depth and a height. Unlike patterns the height of a surface is the height up 
from the depth. In other words a pattern with a depth of .5 inch and a height of .25 inches will be .5 inches 
from the top of the board at the lowest point and .25 inches from the top of the board at the highest point. Once 
created a surface can be merged with other patterns Patterns.

Figure 10�6�  Select Surface Dialog
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Textures

A Texture is a region with a texture to it. To create a Texture select the closed figure or pattern on the board and 
click the Texture Icon in the Tools pull down menu, Tools toolbar or from the context menu

Figure 10�7�  Carve Region Icon

A dialog window will open showing the Textures that are available. Click on the desired texture and a three-
dimensional view of the texture will appear in the viewing area next to the list. The three-dimensional view may 
be rotated and zoomed with the same mouse controls used for manipulating a board (see Using the Mouse). 
Below the preview window is an input box to change the interval or spacing of the texture. Select the desired 
Texture, set the interval and click the ‘OK’ button.

Figure 10�8�  Select Texture Dialog
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Figure 10�9�  Select Surface Dialog

Once created a texture acts the same way as a pattern and can be merged (See Chapter for Patterns). 

Mix and Match

By duplicating region boundaries, applying differnt surfaces/textures, and/or utilizing 
different merge types (see Merging Patterns on page 104), very unique and interesting effects can 
be achieved.
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Chapter 11:  Patterns
This section will illustrate the tools and mechanisms for placing and working with patterns.

Placing Patterns
A pattern is a three-dimensional piece of artwork. Patterns may be selected from the included library of patterns, 
new libraries which are purchased, or imported from picture files in several standard formats (see Import). 
Patterns may be placed on the board, moved, sized, rotated, and merged together in various ways.

 Figure 11�1�  An Example Pattern  

Figure 11�2�  Pattern List Icon

The ‘Pattern List’ (Figure 11.4) is accessed by selection the ‘Pattern Tool’ icon from the ‘Carving’ menu or the 
Carving toolbar.  The pattern library may take a couple of seconds to open the first time it is accessed.  The 
more pattern libraries or the larger any pattern library is, the longer it will take to load the pattern list.  The 
‘Pattern List’ shows the library of patterns available.  The ‘Basic’ and ‘Favorites’ pattern collections are the only 
available pattern collections when the software is first installed.  Initially, there are no patterns in the ‘Favorites’ 
pattern collection.  The ‘Favorites’ collection allows for the sorting of favorite patterns to enable faster access.

The + sign next to a category will expand to show the sub-categories or patterns of the selected pattern 
collection.  Click on a pattern and a three-dimensional view of the pattern image will appear in the viewing area 
beneath the list. The Pattern Preview Window view may be rotated and zoomed with the same mouse controls 
used for manipulating a board (see Using the Mouse).  More information on the Pattern List is in the next 
chapter.

Topics:
•  Control Points
•  Placing Patterns
•  Feather
•  Draft
•  Creating a Region out of a Pattern
•  Outlining a Pattern
•  Merging Patterns
•  Clip Pattern
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Figure 11�3�  Pattern Selection Window

To place a pattern on the board, select the pattern in the library by clicking on it then left-click on the board or 
click and drag the pattern from the Pattern List Window to the board.
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Control Points

All elements placed on a board may be manipulated through the use of Control Points which appear as small 
color-coded dots. However, unlike the control points for drawing elements (vectors), the control points have 
different uses for patterns. Like vectors, the Control Points are left-clicked and dragged to manipulate the 
shape of the patterns. Right clicking on a Control Point opens a menu of options relating to that Control Point.  
Changes made to the control points are reflected on the Input toolbar.

Figure 11�4�  Example Pattern (Raster)

Red Control Point: Red Control Points appear at the corners of patterns.  These control points enlarge 
or reduce the pattern proportionally maintaining the aspect ratio of 1 to 1.  These points can be attached 
to the edge or center line of the board to lock in position (see Chapter on Advanced Drawing Features).  

Yellow Control Point: Yellow Control Points are the midpoints (between the red corners) allow for 
enlarging or reducing the pattern along the X-plane or Y-plane without maintain the aspect ratio.

Green Control Point: Green Control Points allow for quickly changing the angle (rotation) of the 
selected pattern.
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Feather

Feather is the tapered region around a raster item on the board at the board surface. This is a traditional way of 
carving something into a board without having to carve the whole board. 

Feather Tool
When a raster is placed on a board it has a default feather of ¼ inch. The feather can be changed or eliminated 
by selecting ‘Feather’ from the ‘Carving’ menu then selecting the desired width of the feather. Feather can also 
be changed through the Carving toolbar or by right-clicking on a raster and selecting ‘Feather’ from the context 
menu.

Figure 11�5�  Feather Icon

Figure 11�6�  Feather 
Illustration

     

Feather None:
No feather is applied to the raster image.

Feather 1/8:
A 1/8” taper is applied to the raster image.

Feather 1/4:
A 1/4” taper is applied to the raster image.  This is the default.

Feather 1/2:
A 1/2” taper is applied to the raster image.

The Feather now has an added user interface when selected to flip the feather, explained below, or to accept the 
changes as 

Figure 11�7�  
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Flip Feather

The Flip Feather function applies to vector with a region applied.  Instead of having the feather 
apply to the interior (inside) of vector, it moves the feather to the exterior (outside).

Board Surface

Side View

Interior (Default) Exterior (Flip)

Figure 11�8�  Flip Feather Illustration



Draft
Where a Feather is the tapered region around a raster item on the board at the board surface, Draft is the tapered 
region around a raster item on the board at the pattern depth. This is option is mostly used with raster text.  It 
moves the carving bit away from the top of the pattern leaving it intact rather than the carving bit chipping away 
at it. When a raster is placed on a board it has a default draft of ‘none’. The draft can be changed by selecting 
‘Draft’ from the ‘Carving’ menu then selecting the desired width of the feather from the sub-menu. Draft can 
also be changed through the Carving toolbar or by right-clicking on a raster and selecting ‘Draft’ from the 
context menu.

Figure 11�9�  Draft Icon

Figure 11�10�  Draft 
Illustration

     

Draft: None

Draft: Small

Draft: Medium

Draft: Large
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Creating a Region out of a Pattern

Turning a pattern into a region creates a flat-bottomed recess with the shape of the pattern. A pattern can be 
turned into a region simply by selecting ‘Carve Region’ in the Tools menu, Tools tool bar, or the contexts menu. 
(See Regions on page 91.)

Outlining a Pattern
Outlining a pattern creates an outline path around the pattern. If the pattern has internal open areas those areas 
will also be outlined. Outline will outline all patterns and regions that are active on the board. If two patterns 
are active and overlapping each other then the outline will be around both of them. The outline can be used 
like any other vector to apply cut routs or profiles to. The outline function does not remove the original pattern 
but is independent of it once created. This means that the outline will not re-size with the original pattern. 
It also means that the original pattern can be removed without affecting the outline. A pattern or group of 
patterns can be outlined by selecting the desired patterns then select ‘Outline Pattern(s)’ in the ‘Tools’ menu, 
the Tools toolbar, or by right-clicking on the pattern and selecting it from the contexts menu. (See Using Two 
Dimensional Geometry)

Figure 11�11�  Outline Pattern

     
Figure 11�12�  An Example Outline Pattern
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Merging Patterns

A merge occurs whenever two patterns overlap on the board. There are three types of merges

Normal:
The highest point between the two patterns prevails in any overlapping areas.  This is the default 
setting for the Merge feature.

Additive:
The pattern will be added to other patterns occupying the same space, causing it to appear to follow 
the contour of the other patterns.  Patterns that add up taller than the board are proportionally 
squashed

Subtractive:
The pattern will be subtracted from other patterns occupying the same space, causing it to appear to 
be cut into the other patterns.

Merge type can be changed by selecting the merge icon in the carving list or by right-clicking on any raster and 
selecting the desired merge type from the ‘Merge’ menu.

Clip Pattern
Clip Pattern can be used to eliminate a portion of a pattern. Clip pattern is set by selecting the pattern or region 
to be clipped and then by selecting ‘Clip Pattern’ from the ‘Carving’ menu, the Carving toolbar, or from the 
context menu. The Clip pattern options are the following:

Clip None:
The patterns interact normally with no changes applied.  This is the default setting.

Clip Inclusive:
Removes any portion of selected pattern that does not overlay another pattern or region.

Clip Exclusive:
Removes any portion of selected pattern that does overlap another pattern or region.
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Chapter 12:  Advanced Patterns
This section will illustrate the advanced tools and mechanisms for working with images, patterns, pattern 
collections, projects and activations.

Images
The CarveWright Designer Software has the ability to import images in to the software so that they can be used 
as patterns on the board.  The image files are converted to gray-scale where a heightmap is determined for each 
pixel.  The darker a pixel, the less it is carved.  The lighter the pixel, the more it is carved.  This can be changed 
by inverting the image.  Here is a list of the image file types that can be imported into the software:

 Bitmap (*.BMP)
 Joint Photographic Experts Group (*.JPG, *.JPEG)
 Portable Network Graphics (*.PNG)
 Multiple-image Network Graphics (*.MNG)
 Graphical Interchange Format (*.GIF)
 XPixMap (*.XPM)

A Tale of Two Images

The CarveWright Designer Software can import images in to the software.  These files 
are raster images that can not be enlarged without pixelization or loss of image quality.  As 
a pattern is zoomed in upon, The pixel that make up the image will become more apparent.  
Vector images are not capable of being imported into the software but can be created in 
the software by using the vector drawing tools (see Drawing Tools on page 54 for more 
information).  Vector drawings can be zoomed in to the maximum view with no loss of 
quality.

Figure 12�1�  Example Image

Topics:
•  Images
•  Importing an Image
•  Pattern Management
•  Hide Pattern
•  Make Pattern
•  Pattern Purchase Download Instructions
•  Pattern Collections
•  Project Downloads
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Importing an Image

To import a picture or clip art, select ‘Import Image’ from the ‘File’ menu.  The Import Image dialog will open.  
Images can be imported directly from the computer’s clip board or from a file.  Once an image has been selected 
it will appear with a yellow dotted line around it.  The yellow dotted line is the crop box which can be dragged 
to get rid of any unwanted areas of the image. Click the ‘Next’ button to confirm the area selected and view the 
three dimensional image.

  Figure 12�2�  Import Dialog   

Figure 12�3�  Example Crop Box

The crop box in Figure 12.3 will 
only use the image that is within 
the yellow dashed lines (Red 
Area).  If the yellow dashed 
lines are directly over the image 
(Blue Area) then it will be cut 
off from the rest of the image.



109

CarveWright Designer Software Manual
The three-dimensional view may be rotated and zoomed with the same mouse controls used for manipulating a 
board (see Using the Mouse on page 44). The Raise, Lower and Invert actions provide a means of eliminating the 
background or the foreground in the image.

Figure 12�4�  Import Dialog

If there is a need to adjust the crop of the image further, clicking the ‘Back’ button will go back to the previous 
dialog while maintaing the changes made onthe current dialog.  Clicking the ‘Finish’ button will .   A dialog will 
open to save the pattern in the “Favorites” library.   Navigate to the desired location or create a category, give 
the pattern a name, and press save.  The image is now a pattern and can be used in the same way as any other 
pattern.

Figure 12�5�  Pattern Save Dialog
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Hide Pattern

Introduced in version 1.131 of the software is the ability to hide elements on a project.  Right-clicking on an 
element will display the corresponding context menu.  Why the need to “hide” something on a board?  There 
are times when a placeholder is needed to keep objects aligned or a want to see how an item will look without 
completly deleting  it.  There are two methods by which the feature can be activated.  The first is right-clicking 
the item on the board and choosing “Hide” form the context menu.  The second requires that the carving list is 
showing, right-clicking the item in the list and choosing “Hide” form the context menu.

     
Figure 12�10�  Example Pattern (Shown)

Figure 12�7�  Example Pattern

Figure 12�8�  Carving List

Figure 12�9�  Context Menu

       
Figure 12�14�  Example Pattern (Hidden)

Figure 12�11�  Example Pattern

Figure 12�12�  Carving List

Figure 12�13�  Context Menu

An object that is hidden may not be clearly evident on the board but will be easy to see on the Carving List.  
Any objects highlighted in yellow are hidden on the board (figure 12.11).  These objects are still selectable on 
the board, though not visible, so right-clicking on them will produce a context menu where the hide icon is 
toggled (indicated by the blue tinted box depression as in Figure 12.12.)  The differences can be seen overall in 
figures 12.10 and 12.14. 

Figure 12�6�  Hide 
Pattern Icon
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Make Pattern

Also introduced in version 1.131 is the ability to make a pattern from the Basic patterns included in the 
CarveWright Designer Software or patterns that were created by the user, such as imported images, scanned 
items, or image artwork files that were saved as patterns in the Pattern Editor Software.  This tool allows users 
to save complex pattern arrangements for reuse.

Figure 12�15�  
Make Pattern Icon

The first step in using the Make Pattern Tool is to place the patterns on the board as liked.  In the example 
below, a star is being used.  (the two patterns that will be used in the examples below can be found in the Pattern 
List under the Basic Patterns.  Basic > Centers and Fills > Star 01 & Fill 03.)

Figure 12�16�  Example A

The carving list has been turned on in this series of examples to show what is happening on the board as well 
as the items selected.  The pattern Star 01 has been placed on the board.  The pattern Star 01 is in the basic 
category of the Pattern List which means that it can be used to “make” pattern.  If pattern Star 01 were in one 
of the Pattern Lists that were purchased then it would not be usable for this process.  Remember, only patterns 
from the Basic patterns included in the CarveWright Designer Software or patterns that were created by the 
user, such as imported images, scanned items, or image artwork files that were saved as patterns in the Pattern 
Editor Software can be used in this process.
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A second pattern has been placed on the board to the optimal position, in this case at the edge of the star 
(Example B).  In the carving list of the example, the new pattern is inline with the previous pattern.  Placing 
additional patterns would produce the same results.

Figure 12�17�  Example B

With all the patterns placed on the board in the final position, the last step is to group the patterns together.

Figure 12�18�  Example C

In Example D, all the desired patterns 
are selected and saved into a group.  The 
grouped patterns would then need to be 
selected by group.  After selecting the 
group, the Make Pattern Icon (Figure 
12.15) will be available.  If the icon is still 
grayed out, then the group has not been 
selected as in Example E.

Figure 12�19�  Example D Figure 12�20�  Example E
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The Save Item dialog (Example F) box will appear to allow users to specify where to save the pattern to.  The 
example has been saved as ‘Fancy Star’ which can be accessed by going to the Pattern Tool (Example G) like 
any other pattern.

Figure 12�21�  Example F

The newly created pattern can be manipulated like any other pattern and 
retains the original design.

Figure 12�22�  Example G
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Patterns, Collections and Projects Purchase Download Instructions

When purchasing patterns, collections, or projects from the Pattern Store/Pattern Depot (http://store.
carvewright.com/pattern.php), the activation requires a two part process.  The first part of the process is 
activation and the second is downloading.  Unlike the premium features (see Appendix D: Premium Features on 
page 201), the only way to activate or download the patterns, collections or projects is through direct access to the 
internet.  It is not possible to activate the patterns, collections, projects by phone or get them shipped on a disc.

  Must have version 1�126 or later in order to activate 
purchased patterns in the CarveWright Designer 
Software�

After an has been purchased, two e-mails will be sent.  The first e-mail will be an invoice stating what was 
purchased.  The second e-mail will be the same e-mail as before with additional information for any features 
that require downloading or activating.  Each pattern will be separated by the SKU number with a download 
link as well as the necessary Serial Number identified by Serial #1.  If there are multiple purchases of the same 
item, then the appropriate number of serial numbers will be provided.

Figure 12�23�  Pattern Purchase E-mail

To download the item, click the item download link.  (If the link is not active or doing anything, consult your 
e-mail’s options on handling links in an e-mail.  Some e-mail handlers/programs automatically disable links to 
keep users from opening invalid links.  It may be a good idea to add orders@carvewright.com to your e-mail’s 
safelist).  Depending on the internet browser being used, either a save dialog box will appear or the file will be 
downloaded to the default download location.  

Choosing the “Save” button will allow to choose where the item file (*.ptn, *.mpn, or *.zip respectively) 
is saved on the computer.  This is a good option when wanting to keep a backup copy of the item or when 
wanting to activate on multiple computers.  Choosing the “Run” button will immediately open the CarveWright 
Designer Software.

The items can also be opened by double-clicking the file in the computer’s explorer window.   For instructions 
on how to activate premium features, see Activate Licenses on page 164.  If the license has already been activated 
to the customer account, then see Update Licenses on page 162 on how to activate the license to an additional 
computer.

http://store.carvewright.com/pattern.php
http://store.carvewright.com/pattern.php
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Pattern Purchase Import

When the CarveWright Designer Software opens, the Import Image dialog box will appear.  If no changes are 
required, then click the “Finish” button.  Changes are usually not recommended.

Figure 12�24�  Import Image Dialog Box

The Save Item dialog box will appear, prompting where to save the pattern in the software.  Click the “Save” 
button to confirm import, and you will be taken back to the CarveWright Designer Software.

Figure 12�25�  Save Item Dialog box
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Pattern Collection Purchase Import

When the CarveWright Designer Software opens, the Import Image dialog box will appear.  If no changes are 
required, then click the “Finish” button.  Changes are usually not recommended.

Figure 12�26�  Registration - Install Collection dialog

The option “I have purchased this collection” is used when activating the collection for the first.  The dialog that 
follows will allow for activation of the collection.  If the collection has already been activated to the customer 
account or iis being used as a trial, then choose the option “I have not yet purchased this collection and wish to 
try before I buy.” to completete the collection installation.
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Project Purchase Import

Projects that are purchased from the CarveWright website are delivered in a compressed file package known as 
zip.  These file extensions (*.zip) can be opened by most computers but may be handled differently based on the 
operating system.  Consult the computer’s help reference on how to use that computer’s particular zip extraction 
software.

The contents of the zip file is what is needed to carve the projects as they will contain at least one PDF file 
(*.pdf) and one or more project files (*.mpc) The PDF files holds the instructions needed to carve, assemble 
and/or finish the purchased project.  The project files are the files that will be carved on the CarveWright/
CompuCarve Woodworking Machine.  The projects may or may not need additional design changes.  Read the 
entire PDF instruction before attempting to open, change, or upload the project files.

PDF files can be opened with a free program called Adobe Reader.  If the computer does not have PDF reader, it 
can be downloaded by clicking here (www.adobe.com).

http://www.adobe.com
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Chapter 13:  Text Tool
Topics:
• Text
• Editing Text

Text
Text can be added to the board like any other pattern. Once created, text can be manipulated and merged the 
same way as any other pattern.  To create text, select the Text Tool icon (Figure 13.1) in the Drawing pull down 
menu or from the Drawing toolbar, then click a location on the board. The Text Tool dialog box (Figure 13.2) 
will appear. 

Figure 13�1�  
Text Tool

Figure 13�2�  Text Dialog

The rest of the chapter explains the options for the Text Tool Dialog Box.
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Font Box

The font box displays the Fonts installed on the computer that are 
compatible with the CarveWright Designer Software.  The list is 
populated from the Computer’s System Fonts Folder.  The font list box 
will display an example of the text as well as the font name.  Which ever 
font is selected will change the corresponding appearance of the text in 
the Text Box.

The CarveWright Designer Software does not add or remove fonts from 
the computer.

Style

B (Bold)
Applies boldface to entire text making it thicker usually used to placed emphasis on text.

I (Italics)
 Italicizes the entire text slanting it to the right.

Both styles can be applied at the same by selecting both check boxes.

Justification

Align Left
 Aligns the text along the left edge of the bounding box. Align Left is the default setting.

Center (Default)
Centers the text between the edges of the bounding box.

Align Right
 Aligns the text along the right edge of the bounding box.

Spacing

Adjusts the spacing between the characters of text.  Lowering the number 
or moving the slider to the left will bring the text closer together whereas 
increasing the number or moving the slider to the right will make the space 
between each character larger.

Note:  Some fonts may not behave as expected with this feature
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Arc

The arc degrees for text will make the ends of the text come closer together 
to form a circle.  This ranges from -360 to 360 forming a standard or 
reverse arc or circle for the text. 

Rout Mode

Rout mode refers to the style of cut for the entire text.  There are normally two options 
available, but users with a centerline text license will see the option “Centerline”.

The Raster text option places the font on the board as a picture which has the same 
properties as a pattern which can be adjusted by using the bounding box controls.  Raster 

text is the slowest of the Rout modes but allows for the most interaction with other items on the board.  The 
rules of raster pattern still apply.

The Outline text option creates a vector path that traces each letter and by default assigns a 90 degree V-bit to 
the text path.  Again, the sizing of the text is controlled through the bounding box surrounding the text.  The 
bit can be changed by going to the Select Bit icon once the text is placed on the board.  The rout mode options 
faster than raster because the cutting head follows the vector path instead of going left to right like an ink jet 
printer.

Text Box

The text box is where any desired text is inserted.  The typed text will appear with any of the features selected 
with the exception of Rout Mode.  The Rout Mode will not take effect until the text is placed on the board.  The 
text box does not automatically wrap the text to the bounding box as seen in some word processing programs.  
Use the Enter button on the keyboard (Return on some keyboards) to break to the next line.  Any and all 
changes to text will be reflected throughout the text.  It is not possible to apply mixed features within the same 
text instance.

Editing Text
Once text has been placed, it may be manipulated the same way as any other pattern. To change the font or the 
text itself, right-click the text and pick the Edit Text option from the context menu.  Since letters in many fonts 
can run together, there may be a certain amount of trial & error that needs be used with the Bit Optimization 
levels to make the letters appear more distinct when carved.  If text is made small be sure to carve it very 
shallow, as the small areas inside the text will easily chip out.
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Adding or Removing Fonts

The CarveWright Designer Software uses the fonts stored on the operating systems’s fonts folder.  The 
CarveWright Designer Software does not add any fonts to the operating system’s fonts folder.  The 
CarveWright Designer Software does not remove any fonts from the operating system’s fonts folder.  
The CarveWright Designer Software uses true type fonts.  With all that information out of the way...the 
fonts folder is located at the following locations for each respective operating system:

Windows 2000/Windows XP/Windows Vista
 - C:\Windows\Fonts

Mac OS 10.4 or later
 - HD > System> Library > Fonts

Consult your Computer’s Operating System manual for adding fonts to your computer. 
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Chapter 14:  Layout Tools
This section will illustrate the various layout tools and mechanisms that are available.

Mirroring
Mirroring is a very useful tool for laying out symmetric patterns. The software allows any figure to be easily 
mirrored across the board’s center lines (X-axis and Y-axis) by means of the Mirror option in the Layout 
menu or from the context menu that appears when right-clicking (Ctrl + clicking) on a figure. A figure may be 
mirrored horizontally , vertically , diagonally or across all axes. Any changes made to a mirrored figure will 
reflect in its mirrored copy.

Mirror Vertically
Shift + Ctrl + H
( ñ + z + H)

Mirror Horizontally
Shift + Ctrl + V
( ñ + z + V)

Mirror Diagonally
Shift + Ctrl + D
( ñ + z + D)

Mirror All
Shift + Ctrl + A
( ñ + z + A)

Figure 14�1�  A Mirror All Figure

A mirrored figure may be removed by either selecting it and deleting it in the normal way, or by deselecting it in 
the Mirror option list.  Deleting the original image will remove all mirrored instances of the item.

LEGEND

Mirror Vertically

Mirror Horizontally

Mirror Diagonally

*The example uses all three 
mirrors because mirror all 
was selected.

Topics:
•  Mirroring
•  Carving List
•  Group
•  Center
•  Alignment
•  Flip and Rotate
•  Snap and Grid
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Carving List

The Carving List is a powerful tool for organizing and manipulating objects on the board. Choose the Carving 
List Icon in the View menu or from the Toolbar List to open the Carving List. There are two columns in the 
Carving List: “Carvings” and “Merge”. Anything that is placed on the board will appear in the “Carvings” 
column with the name of the object and an icon representing what the object is.

If the object is a pattern, a thumbnail of the pattern will be shown. If the object is a drawing element with 
functions applied to it, icons of the functions will appear next to the drawing element icon. With any item that 
can be merged (see Merging Patterns on page 104) a merge icon will appear under the “Merge” column. The items 
in the Carving list can be renamed by double clicking on the item and typing the new name or right-clicking 
(Ctrl + clicking) and selecting “rename”. 

Selecting any item on the board will highlight that item in the carving list as well, selecting any item in the 
carving list will highlight that item on the board. Multiple items can be selected in the carving list. To select 
multiple non-consecutive items hold the Ctrl (z) key down while left-clicking items in the carving list. To 
select multiple consecutive items hold the Shift (ñ) key down while left-clicking items in the carving list.

Figure 14�2�  Carving List icon

     

Figure 14�3�  Carving List
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Group

Patterns can be grouped together by highlighting multiple patterns (either on the board or in the carving list) 
then selecting the Group button at the bottom of the carving list or by right clicking and selecting Group in 
the context menu. The main purpose of the Group function is to provide greter control over merging patterns.  
Merge types can be applied to groups as a whole.  The merge icon will appear under the merge column next to 
the group.

Figure 14�4�  Group Icon

For example: lay one pattern on top of another pattern then add both of those patterns as a group to another 
pattern or surface. This can be done by placing two patterns on the board and adjusting their depth and height so 
that one appears on top of the other. Group these patterns and set the merge type of the group to additive. Draw 
a rectangle around the patterns and create a surface. The two patterns are merged normal to each other but they 
both follow the contour of the surface.

Figure 14�5�  Example Group

Note:  The merge selection for a group override the individual merge selections.
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Center

Any item(s) placed on the board can be centered and locked in position to keep it from moving.  Select the 
item to center then select Center from the Layout menu or right click on the pattern and select Center from the 
contexts menu.  The object can be centered horizontally , vertically or both horizontally and vertically.  The 
center options are toggles and will remained activate unless disabled.

Center Vertically
Ctrl + V ( ñ + V)      

Center Horizontally
Ctrl + H ( ñ + H)      

Center Both

Figure 14�6�  Sample Board with Axis Layout

LEGEND

Vertical (X-axis)

Horizontal (Y-axis)

Center Point
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Alignment

Alignment applies to two or more items. Any geometry placed on the board can be aligned with another. Select 
the items to align then select Align from the Layout pull down menu or right click and select Align from the 
context menu.

Center
The Center Group options move the center of the group of selected items to the center of the board without 
locking it in position like the Center option described at the beginning of the Chapter.

Center Group Horizontally: Horizontally centers the selected objects as a whole with the center of 
the board.

Center Group Vertically: Vertically centers the selected objects as a whole with the center of the 
board.

Align
The Align options below, line up the selected items on the board to the closest selection.

Align Tops: Aligns the top-most points of the objects selected.

Align Bottoms: Aligns the bottom-most points of the objects selected.

Align Lefts: Aligns the left-most points of the objects selected.

Align Rights: Aligns the right-most points of the objects selected.

    
Figure 14�7�  Example Align Tops
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Flip and Rotate

Flip and Rotate is a quick way to reorient an item. The Flip and Rotate functions are found on the Layout Menu.  
They can also be accessed by right-clicking (Ctrl +clicking) on a pattern or vector and selecting Flip and Rotate 
from the context menu.

Flip Vertically: Flips the item in place from top to bottom.

Flip Horizontally: Flips the item in place from side to side.

Rotate 90 CW: Rotates the pattern clockwise 90 degrees (to the right)

Rotate 90 CCW: Rotates the pattern counter clockwise 90 degrees (to the left)

Rotate 180: Rotates the pattern 180 degrees (basically flips the object vertically and horizontally at 
the same time)

Note:  Vector shapes can be flipped but cannot be rotated
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Snap and Grid

There may be times when the precision of the computer is desired when designing a project.  The features 
desired are described in this section and can be found on the Snap to grid dialog box accessed the Snap... Menu.
 

 
Figure 14�8�  Layout 

Menu > Snap���  Figure 14�9�  Snap to Grid Dialog

Snap
There are two types of snap available. Snap to Edges snaps the control points of the object to the edge of the 
board when the control points are close to the edge. Snap to Grid snaps the control points of the object to the 
grid point closest to it. The interval of the grid can be changed through the Snap to grid dialog.

Snap to Edges
     

Snap to Grid

Snap to Grid can be turned on and off in the Snap dialog or by pressing Toggle Snap to Grid in the View pull 
down menu or the View tool bar. Snap to Edges can be turned on and off in the Snap dialog or by pressing 
Toggle Snap to Edges in the View pull down menu or the View tool bar. 

Figure 14�10�  Example Rectangle w/Snap to Edges On
  

Figure 14�11�  Example Rectangle w/Snap to Grid On
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Grid

The grid lines can be toggled on or off by selecting Toggle Grid Lines from the View pull down menu the View 
tool bar or by selecting the View Grid option on the Snap to Grid dialog box.

Toggle Grid Lines

Figure 14�12�  Toggle Grid Lines - Off
  

Figure 14�13�  Toggle Grid Lines - On

Note: The snap options will work whether the grid is visible or not.

When the Snap interval is set, it calculates from the left top most corner of the board which sometimes  may 
not be lined up with the center of the board (where the X-axis and Y-axis cross).  The Center Grid option when 
checked changes grid to ensure that the center point and grids align perfectly.

    
Figure 14�14�  Center Grid Example

In the Center grid Example above, the illustration on the left is with the option turned off and the illustration on 
the right is with the Center Grid option checked.  The illustration on the right has the grid line centered on the 
center point.
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Chapter 15:  Board and View Manipulation
This section will illustrate some of the mechanisms for starting a new board, placing objects, and manipulating 
board objects.

Changing Board Dimensions
The dimensions of a board can be changed at anytime by selecting board setting under the Edit pull down menu.

Figure 15�1�  Board Settings Dialog

Full Scale Carving

To carve the designed project at full scale will require a board of the designed size or larger.    
If the board does not meet the minimum deminsions, the project may not carve to the desired 
size.

Example:  A 7 x 7 x 1 board inserted into the machine to carve a project designed with the 
deminsions 10 x 10 x 1, will scale down with default settings selected on the machine. 

Topics:
•  Changing Board Dimensions
•  Changing Board Appearance
•  Lighting Direction
•  Perspective View 
•  Finding the Depth and Position on a Board
•  Window Mode
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Changing Board Appearance

To help with visualization of the final product, the type of wood and stain and even the type of finish (flat, semi-
gloss, gloss) can also be set in the Board Settings dialog.

Figure 15�2�  Board Settings Dialog

Personal Material

It is possible to add your own wood type backgrounds.  Navigate to the folder C:\Program 
Files\CarveWright\woods1 where you will find jpeg images of the wood backgrounds in the 
software.  These are the backgrounds that software pulls from.  Any changes to these images 
will be reflected in the software.  Do not alter the images that are already there but add new 
images to the folder to get new backgrounds in the software.  The backgrounds must 512 x 
512 pixels and jpeg images to use them as background images.

The naming format is Type_Wood+Name.  The underscore separates the Type from the 
Wood Stain.  The plus sign separates the type or wood name, respectively, with a space.  
You will then have custom backgrounds available under your Board Settings - Stain/Finish 
selections.

For each-user Woodtype, there must be a “Natural” Stain in order to be loaded.
  Example:  “Corian_Natural.jpg”
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Lighting Direction

The direction and intensity of the light source pointed at the board will affect the appearance of 
elements carved into the board. The direction of the light source can be changed by selecting 
View ð Lighting Direction or the lighting direction icon if it has been manually added to the 
toolbars and select the desired direction from the sub-menu.

Figure 15�3�  Lighting Direction Sub-menu

Figure 15�4�  Lighting Direction Illustration



134

Chapter 15:  Board and View Manipulation (Advanced)
Perspective View 

Perspective is the taper of an object as it goes into the screen giving it a more natural three-dimensional 
appearance. The perspective view can be toggled on or off from View ð Toggle Perspective View menu. The 
level of perspective view can be changed through preferences (See Chapter 3).

Figure 15�5�  Toggle Perspective 
Icon

 
Figure 15�6�  Preferences (Perspective)

Finding the Depth and Position on a Board
At times it is important to know the depth and position at a point on the board. This can be done by moving the 
mouse to the desired point on the board and looking at the position readout found at lower left hand corner of 
the main window. This readout indicates board face, X position (length), Y position (width), and Z (depth) in 
that order. The X an Y readings are always taken from the upper right hand corner of the board.

Figure 15�7�  Status Bar (Depth & Position)

Face and Edge

There are 6 focal points to a board (Front Face, Rear Face, Right Edge, Left Edge, Top 
Edge and Bottom Edge.)  All these will display on the screen if looking at the appropriate 
focal point, however currently it is not possible to design on any of the edges.

 

Notice the bottom 
and top edges have 
switched when the 
board is flipped.
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Window Mode

  This feature is in version 1�130 of the software or later�

Introduced in version 1.130, the CarveWright Designer has the ability to run 
multiple project windows that can be arranged within one software window.  
The project windows can also be tabbed for quick click access to multiple open 
pieces/projects.

Switch Project Windows
At any given time, one (and only one) project window is the active window.  
This is the window that accepts input, and it is the window on which commands 
will work. The active window’s title bar is a different color, and the window 
appears at the top of the stack of windows. To work in a different window, make 
that window active. There are several ways to make a different window the 
active workbook:

• Click another window, if it’s visible. The window clicked moves to the top and becomes the active 
window.

• Press Ctrl+Tab (z+Tab) to cycle through all open project windows until the desired window appears on 
top as the active window. Shift+Ctrl+Tab (Shift+z+Tab) cycles through the windows in reverse order.

• Click the Window menu and select the desired window from the bottom part of the pull-down menu (the 
active window will have a check mark next to it).

Moving & Re-sizing Windows
To move a window, make sure that it’s not maximized. Then click and drag its title bar with the mouse pointer.

To re-size a window, click and drag any of its borders until it’s the desired size. When positioning the mouse 
pointer on a window’s border, the mouse pointer changes to a double-sided arrow (See Movement Arrows 
above), now click and drag to re-size the window. To re-size a window horizontally and vertically at the same 
time, click and drag any of its corners.

I like to move it, move it!

A workbook window cannot be moved or re-sized if it is maximized. A minimized window  
can be moved, but doing so has no effect on its position when it is subsequently restored.

To view all the project windows move and re-size the windows manually, or let the CarveWright Designer 
Software.  The Window ð Tile or Window ð Cascade command (Figure 5.16.) will arrange the windows in the 
appropriate selection, as shown in Figure 5.17.

Figure 15�8�  Window Menu
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Figure 15�9�  Project Windows Arrangement

The Window menu can display up to nine windows. If there are more than nine project windows open, choosing 
More Windows (which appears below the nine window names) will display them.

When one project window is maximized, all the other windows are maximized as well (even though they are not 
visible).  Therefore, if the active project window is maximized and then switched to another project window, the 
new active project window is also maximized. If the active project window is maximized, it is not possible to  
select another window by clicking it (since other windows aren’t visible).  To switch to another project window, 
one of the switch project window methods will have to be utilized.

Closing windows
If there are multiple windows open, it may be desired to close those windows that are no longer needed. To 
close a window, select File ð Close or simply click the Close button (the X icon) on the project window’s title 
bar. If the project window is maximized, it’s title bar is not visible, so it’s Close button appears directly below 
the CarveWright Designer Software Close button.

When closing a workbook window, the CarveWright Designer checks whether any changes were made since 
the last time the file was saved.  If no changes have been made then the window closes without a prompt. If  
changes have been made, the CarveWright Designer will prompt to save the file before it closes the project 
window.

Tabbed Project Windows Enabling
To enable this feature, go to Window ð Toggle Tabbed Windows.  The tabs will display the default project name 
or the names of the projects as they were saved unless room does not permit. The feature works the same on 
both Windows and Mac operating systems however the tabs are on centered on the Mac (Figure 5.18) and on 
the left on Windows (Figure 5.19).

Figure 15�10�  Tabbed Windows Enabled (Mac)

Figure 15�11�  Tabbed Windows Enabled (Windows)
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Chapter 16:  Uploading
The contents of this chapter highlight the features associated with uploading a project to the memory card.

Topics:
•  Upload
•  Auto-Jig
•  Upload-to-Flash
•  Quality Settings

  This menu option has been updated since version 1�113 
but has for the most part stayed the same�  This chapter 
is being from written from the 1�132 version software�

Programmer and Memory Card
Once a project has been created it must be uploaded to the memory card to be transferred to the CarveWright/
CompuCarve Woodworking Machine. The two items below are required to complete this process: 

Figure 16�1�  USB Programmer

The USB Programmer allows the computer to interface to  
the memory card.  It plugs into any open USB port on the 
computer.  There are two lights on the programmer.  The green 
light lets the user know that the Programmer is connected to a 
USB port while the red light indicates that the card is in use.

Figure 16�2�  CarveWright Memory Card

The Memory Card is required in order 
to transfer projects from the Designer 
software to the Woodworking Machine and 
also holds the firmware needed to operate 
the machine.

The memory card only works with the 
Machine and Programmer and can not be 
accessed through a computer’s explorer 
function.  It is not a standard PCMCIA 
card and can only be purchased through 
CarveWright or authorized dealers. 
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Before the upload process can be begin, the USB programmer needs to be plugged in to the USB port of the 
computer.  The green light should be visibly lit on the programmer.  (The computer may or may not identify that 
a new item has been plugged.  Don’t get alarmed if it doesn’t.)  Once the Programmer is securely plugged in 
then the memory card can be inserted into the programmer slot.  There will be no on screen indication that the 
memory card has been inserted.

Figure 16�3�  Memory card insertion 	

Figure 16�4�  Inserted memory card

Note: A portion of the memory cards space is allocated for the firmware and other functions making unavailable 
for information storage. As a result, the upload or flash manager will report less space available. 

Auto-Jig
Sometimes a designed project may conflict with the machines parameters that have been stored in the Designer 
software.  The Auto-Jig dialog box displays the reason(s) why the project will interfere with the machine.  In the 
event that the CarveWright Designer Software recognizes that any of these conditions are met within a project, 
the software will display a warning when the project is uploaded to the memory card. The specific conditions 
will be listed, and the user may choose to ‘Ignore’, ‘Manual Jig’, or ‘Auto Jig’.

Figure 16�5�  Auto-Jig dialog
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When presented with the Auto-jig dialog, the following messages will display on the screen for the attached 
reason:

Display:

Reason:
Wide vertical cuts across the top surface if the workpiece can cause the compression rollers to fall during a 
project, affecting the machine’s ability to move the workpiece.  The machine may not be able to get a grasp 
on the material resulting in slippage which will be visible in stair-stepping.

Display:

Reason:
Cuts through the board along the top edge of the workpiece (as viewed in the software) can interfere with 
the Board Tracking Sensor and affect the machine’s ability to track the position of the workpiece.  The 
machine uses the top edge in conjunction with the board tracking sensor to track where the board is in 
relation to the bit.  If the board tracking is not able to keep constant contact with the board, it will result in 
the machine carving continuously along the same horizontal path.

Display:

Reason:
Carvings on the rear face of the workpiece and near the bottom of the workpiece (as viewed in the 
software) can also interfere with the Board Tracking Sensor when the workpiece is flipped over.

Display:

Reason:
Cuts with the Cut Tool along the front end of the workpiece can potentially break the cutting bit if 
the workpiece leaves the Board Tracking Sensor and the machine loses high-precision tracking of the 
workpiece.

The user is left with the options to ‘Ignore’, ‘Manual Jig’, or ‘Auto Jig.’  ‘Ignore’ is the option to choose if the 
board that is going to be carved is 7” longer than the designed (virtual) work piece.  Choose ‘Manual Jig’ if the 
project that is going to be carved is going to be sitting in jig or sled.  This let’s the machine know that it will not 
be going beyond the dimensions designed for.  The last option is to choose the ‘Auto Jig’ option which will add 
to measurements that were originally called but preserving the design with no alteration to it.
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Upload Project

The Upload Project dialog (Figure 15.6) show all the file settings that can be made before the project is 
uploaded to the memory card.  Any projects that are currently on the card can also be seen on this screen along 
with the space available and the file size for the current project.  This is very important if there is not enough 
room on the memory card to upload it.  If the previous situation is the case, then cancel the upload process 
and go to ‘Flash Manager’ under the ‘File’ Menu (explained in the next chapter: Memory Card Management.)  
Otherwise continue with the upload process with the information for the Upload Project dialog.

Figure 16�6�  Upload to Flash Dialog

File Name
The file name is the name that will be stored on the memory card for the current project and will display on the 
CarveWright/CompuCarve Woodworking Machine display screen when selecting the which project to carve.  
The default filename is filename that has been saved to the computer.  If the file has not been saved then the 
default name that will display is “Unnamed”.

A project can not be recovered from the memory card so it is recommended that the project is saved to the 
computer before closing the CarveWright Designer Software.
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Quality Settings

The Quality Setting selected for the project will change the detail  of the carve as well as the amount it will take 
to carve.  The following options are available from the Quality settings drop down box:

Draft: Requires the minimum time to carve but spacing of the passes 
will be noticeable. This setting is useful for large carvings that will 
not be viewed up close.

Normal: This is the standard balance between carving time and 
output quality. Good quality carvings though some passes may still 
be visible with this setting.

Best: Requires a longer time to carve than the Normal setting. High 
quality carving with no passes visible

Optimal:  Maximum carving time with the most accurate carving 
results.

Run Time
Based on the Quality setting selected, Estimated Project Run Time will change accordingly.  This is an estimate  
and not an exact time as there are other factors that can increase this time such.  The format for reading the 
estimated time is hours, then minutes, then seconds.  This would mean that 07:13 is seven minutes and thirteen 
seconds, not seven hours and thirteen minutes.

Designer Version
The designer version will display what the current software version is installed that the project was designed 
in.  This is very important when the software is updated as changes to the operation of the CarveWright/
CompuCarve Woodworking Machine can conflict with the instructions of the Project that is to be carved.  It is 
best to re-upload the projects on the memory card whenever an update has been installed to the computer.
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Project Orientation

It is important to note the orientation of the project as viewed on the computer screen 
as compared to the orientation of the project as it is being carved on the machine.  This is 
important in the event that a specific orientation or location of the project on the material is 
desired.  The on screen will be carved inverted at the machine. 

  
Figure 16�7�  ORIENTATION OF THE 

PROJECT ON THE COMPUTER 
SCREEN  

Figure 16�8�  ORIENTATION OF THE PROJECT 
IN THE MACHINE
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Chapter 17:  Memory Card Management

This chapter focuses on the Flash Manager which works 

Flash Manager
The Flash Manager is the interface used for the CarveWright/CompuCarve Memory Card.  Where upload is the 
only way to load projects on the memory card, the Flash Manger is the only interface that will let a user view or 
change any information on the memory card.  Some of the information may be familiar from the Upload dialog 
explained in the last chapter. The following tools and information are available from the Flash Manager dialog 
box:

• View projects, scans or both (default)
• Space Available on memory card
• Information for project (File Name, Size, Estimated Run Time, Quality, & Designer Version)
• Delete individual projects/scans
• Delete all projects and scans at once
• View the firmware information on the memory card that is operating the machine

Figure 17�1�  Flash Manager dialog

Topics:
•  Flash Manager
•  Delete
•  Firmware
•  Formatting
•  Download Scan



146

Chapter 17:  Memory Card Mangement
Delete

There are two methods for deleting information off of the memory card.  The first method is the direct delete 
method.  Selecting a project or scan on the File Name list will allow the ‘Delete’ button to be clicked.  If there 
is no file selected, then the default state for the ‘Delete’ button grayed out.  Deleting a project off of the memory 
card does not affect any files that are stored on the computer itself.  Deleting an item off of the memory card 
immediately makes that space available for use which will be reflected in the Available card space label.

Firmware
The Firmware is the code required to run the CarveWright/CompuCarve Woodworking Machine.  It is supplied 
by the CarveWright Designer Software.  Whenever the CarveWright Designer Software is updated and the card 
is accessed (such as uploading a project or opening the Flash Manager), then the user is prompted to update the 
firmware on the memory card accordingly.  There may be a situation that the option was declined for one reason 
or another.  Clicking the ‘Firmware’ button will display a dialog box (Figure 16.2) that allows the user to load 
the latest firmware or choose the firmware to load on the memory card.

Figure 17�2�  Choose Firmware dialog 

The Default Firmware Version matches the current version of the software installed on the computer.  The 
Installed Firmware Version displays what firmware is on the memory card.  If the two do not match then 
clicking the ‘Latest Firmware’ button will update the firmware on the memory card.  During this process, there 
will be a progress on the screen and the red light will be lit on the USB Card Programmer.  Do not remove the 
card during this time.

The ‘Choose’ button allows for selection of a specific firmware file.  This feature is not for novice users and any 
users that believe there is a need use should contact the CarveWright/CompuCarve Support Team before doing 
so.
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Formatting

Earlier in the chapter under the Delete section, it was mentioned that there are two ways to delete information 
form the memory  card.  The second method to delete information from the memory card is the ‘Format’ button 
(Figure 16.1).  Where the ‘Delete’ button removes one item at a time, the ‘Format’ button clears the entire 
memory card in one-click.  Because this wipes the entire memory card, the software confirms the process with a 
Confirm Flash Card Format dialog.  Clicking the ‘Cancel’ button will return the user back to the Flash Manger 
dialog, but the ‘Erase and Format’ will clear the entire memory card.

Figure 17�3�  Confirm Flash Card Format

 The only information that is retained on the memory card after using the Format option is the firmware that was 
previously installed.

Download Scan
The ‘Download Scan’ button is for users that have a CarveWright Scanning Probe registered as well as the 
Pattern Editor Software activated (registering the scanning probe will activate the Pattern Editor Software.  See 
the chapter for the Pattern Editor Software for instructions on how to register the scanning probe.)  If scanned 
project from the scanning probe has been stored on the memory card and a valid Pattern Editor License is 
installed on the computer then ‘Download Scan’ button will become available for use.  If the previous criteria is 
not met then the button will stay gray and dimmed.
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Chapter 18:  Help

This section will illustrate the various items that are available under the Help Menu.

The Help Menu can be accessed by selecting Help from the Menu Toolbar (Figure 17.1) or by pressing Alt + H 
(z + H) which will display the menu options that are discussed in the chapter.

Figure 18�1�  Help Menu (Windows)    Figure 18�2�  Help Menu (MAC)

Help Contents
Use the Help Contents menu to access CarveWright’s help system filled with a lot of the information that is 
in this book.  It is a quick and easy way to get information with different ways to search.  The layout of the 
information may will change from operating system and web browser but the content will not.

Topics:
•  Help Contents
•  Sample Projects
•  Tutorials
•  Start Wizard
•  Pattern Store
•  Check for Updates
•  Manage Licenses
•  Hardware Manual
•  Web Account Login
•  Online Forum
•  About
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Sample Projects

  This feature changed in version 1�130 of the software 
but has been available with every version prior�

The Sample Projects menu option allows for quick access to the Sample Projects that are loaded with the 
installation of the CarveWright Designer Software.  The sample projects are stored in the program files folder 
along withe the Software files.  Whenever the sample projects are used from the Help Menu, it changes the 
location of the last open project and subsequent saves after that default to the folder.  It is not recommended 
to save to this folder but to a folder that is stored somewhere more generally accessed like the desktop or User 
documents folder.  

The Sample Projects are complete projects that can be uploaded directly after opening them.  In version of the 
software after 1.130 of the software, a dialog menu was added so that a preview of the sample may be seen 
before selecting the sample.  

 
Figure 18�3�  Sample Projects Dialog (MAC)

 
Figure 18�4�  Sample Projects Dialog (Windows)

The samples are like any other projects that they can be left in the original state or edited.
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Tutorials

  This menu option was not added to the software until 
after version 1�127�  There must be an internet 
connection to use this option�

Some may be able to read this book or the Help Menu documentation and begin designing projects right away.  
For those that may want some additional video based instructions, there are Tutorials that are located the 
CarveWright website under Support > Downloads.  The Tutorial Menu option goes directly to these tutorials.  
These videos can be watched directly on the website or downloaded to take to other computers.  An internet 
connection is required in order to download tutorials but is not required to view the tutorials files.

Start Wizard
If the Start Wizard (see “Startup Wizard” on page 160) has been closed or set to not display, selecting this menu 
option will bring up the Start Wizard.

Figure 18�5�  Start Wizard

Pattern Store

  This menu option was not added to the software until 
version 1�123�  There must be an internet connection to 
use this option�

The Pattern Store menu option is a direct connection to CarveWright’s very own online Pattern 
Store.  The Pattern Store icon can also be found on the Carving Toolbar.  The pattern store is filled 
with patterns, collections of patterns, and projects that can be purchased.  This database of available 
objects is being continuously updated with new and exciting patterns & projects.  A store account 

must be established in order to purchase items from the online store.  A customer account is not the same as a 
store account.
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Check for Updates

  There must be an internet connection to use this option�

Periodically updates are released for the CarveWright Designer that can be downloaded with a high-speed 
internet connection.  When this menu option is selected, a web page will show the version of the software on 
the computer that is being used and the current version available.  If the version on the computer is older than 
the current version available, then appropriate download links will be displayed.  It is recommended to save the 
appropriate installer to the computer instead of running it directly from the internet.  The CarveWright Designer 
Software will have to be closed in order to initiate the software update.

There is no charge for software updates within the same major software revision.  If a high-speed internet 
connection is not available then a software update disc can be purchased for a minimal cost from the online 
store or by contacting the CarveWright Support Team.

Manage Licenses

  This menu option has been updated since version 1�124 
but has for the most part stayed the same�  This section 
is being from written from the 1�132 version software�

The Manage Licenses Menu option allows a user to see the licenses installed on the current computer for the 
CarveWright Designer Software as well as the ability to activate newly acquired features.  Some the capabilities 
require an internet connection.  This menu option is explained in more details in the Manage Licenses Chapter.
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Figure 18�6�  Manage Licenses Dialog (Your Licenses)

Hardware Manual

  This menu option was not added to the software until 
after version 1�131�  

From time to time there are updates to the Hardware Manual for The CarveWright/CompuCarve Woodworking 
System.  The current version of the Hardware Manual at the time of release of the CarveWright Designer 
Software is installed with the updates and can be accessed by selecting the Hardware Manual menu option.  A 
PDF file reader program must be installed on the computer in order to read these types of files.  PDF Reader 
programs can be downloaded at no cost by doing a search on the internet.

Web Account Login

  This menu option was added to the software in version 
1�130�  There must be an internet connection to use this 
option�

Most software features for the current computer can be accessed through the Manage Licenses Menu options 
however there are some that can’t be.  Web Account Login menu option takes a user directly to the Registration 
Page which when logged in shows the features, licenses, computers, woodworking machines, and any other 
information that is on the Customer Account.  This page can be accessed from any computer that is connected to 
the internet by going to the CarveWright website and selecting Support > Software Registration.
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Online Forum

  There must be an internet connection to use this option�

The online forum, much like the tutorials is another source of learning for the both the CarveWright Designer 
Software as well as the CarveWright/CompuCarve Woodworking Machine.  The difference is the forum is 
filled with other users that share years of woodworking, computer and life experience to produce and prompt 
for some great help and carvings.  This menu option opens a web page to the Forum.  There must be an internet 
connection in order to use this menu option.

Anyone is able to read through the forum but only registered forum users may post.  The forum account, like the 
store and customer account are not connected so a forum account must be created in order to post to the forum.  
The forum can be accessed form any computer that is connected to the internet by going to the CarveWright 
Website and choosing Community > Forum.  

About
The about menu option will display a picture (most often seen when the software opens, for a split second) with 
the version number of the software, name of software, product logo and company name.  The picture must be 
clicked on in order to continue regular use of the software.  

Figure 18�7�  About Screen

On a MAC computer Operating System, ‘About’ is accessed 
differently than on a PC computer.  Notice the difference in Figure 
17.1 and 17.2.  MAC Users must go to the ‘CarveWright Menu’ 
(Figure 17.8) and ‘About CarveWright’.  The same information 
above applies.

Figure 18�8�  CarveWright Menu (MAC)
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Chapter 19:  Preferences
This section will illustrate some of the mechanisms for starting a new board, placing objects, and manipulating 
board objects.

Overview
Basic settings can be set in the preferences dialog found under the Edit menu (Windows) or CarveWright menu 
(Mac).  The two tabs, General & 3D Graphics, found on the preferences dialog box contain various options to 
improve speed, viewing, and measurements that will be used for every project that is created and/or opened.  
These settings are not stored within the projects themselves.
 

Figure 19�1�  Preferences Dialog - General tab

Tool Reset
Enabling this feature will change any of the tools selected back to the pointer tool after one use.  Deselecting 
this option will keep the tool selected enabled unless the user changes it another tool.

Display Startup Wizard
With this option enabled, the designer software displays a screen (See Figure 4.3) to assist with common file 
options if the software is opened and there are no open files.  When this option is deselected then the Startup 
Wizard is not displayed.

Topics:
•  Overview
•  Tool Reset
•  Display Startup Wizard
•  Memory Rendering Cache
•  Measurement Preference
•  Lighting Level
•  Perspective Level
•  Hardware Acceleration
•  Lighting Direction
•  Standard Functions
•  Startup Wizard
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Memory Rendering Cache

The Rendering Cache is automatically set based on the operating system the software is installed on. The cache 
can be increased to improve the rendering speed of some carvings.

Vista vs the World, part 1

All Windows Vista users are urged to change their render cache from the default setting 
to 256.  This will prevent crashes from occurring due to lack of speed as Windows Vista 
reserves a certain amount of RAM for secure programming.

Measurement Preference
Changing the Measurement Preference (Figure 4�1) from the default Standard (Inches) to Metric (Centimeters) 
will change all the measurements from inches to centimeters.  In order for this option to take effect, the software 
must be restarted.  This feature will only work on projects created after the switch.  If a project was saved prior 
to the change using inches, then it will continue to measure in inches when it is opened again.
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Figure 19�2�  Preferences Dialog - 3D Graphics tab

Lighting Level
The amount of simulated light on the board in the CarveWright Designer Software can be changed using the 
sliding adjustment.  The lower the light source, the darker piece will appear on screen.  The higher the light 
source, the brighter the piece will appear on screen.  This option is most often used to simulate how the piece 
will look in a particular setting before being carved.

Perspective Level
Changing the slider position where it is closer to low will make the perspective closer whereas the opposite will 
make the perspective farther away from the piece.  See Chapter 5: Board and View Manipulation on page 49 for 
more information.

Hardware Acceleration
Many computers have hardware support for improving graphics performance.  Although usually helpful, 
at times, this feature can cause problems with graphics intensive software like the CarveWright Designer 
Software.  The CarveWright Designer Software typically uses the system default (Auto) setting for hardware 
acceleration, but in some cases it is desirable to override this behavior.  The default Auto setting will have the 
computer initialize the feature as needed, the ‘On’ setting will have the feature on at all times, and the ‘Off’ 
setting will not use the feature at all.

Vista vs the World, part 2

All Windows Vista users are urged to change their hardware acceleration from the default, 
Auto, to Off.  Windows Vista sets the hardware acceleration for the computer to On.  When 
the CarveWright Designer Software attempts to enable acceleration, it causes internal issues.

Lighting Direction
As the simulated light intensity can be changed, so can the lighting direction.  The default, Top Left, can be 
changed to the other 7 directional points.  The lighting Direction can be found under ViewðLighting Direction 
as well.  This feature is explained more in depth in Chapter 5: Board and View Manipulation.
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Standard Functions

A Tale of Two Keyboards

Though all the features are the same between the two operating system, the keyboard 
commands or shortcuts for the two are different.  The button commands for a Windows 
computer are listed with the button commands for a Mac based computer in parenthesis.  
Example: Ctrl + L (z + L)

  
+

  
Windows Keyboard Shortcut       

  
+

  
Mac Keyboard Shortcut

New Piece/Project:
Select this button to launch an operating system dialog that prompts for the size of a new board.  
The defualt size will be the last board size saved.  Pressing Ctrl + N (z + N) will make this option 

accessible as well

Open Piece/Project:
Select this button to launch an operating system File Open dialog to recall a piece or project previously 
saved to the computer.  Pressing Ctrl + O (z + O) will make this option accessible as well

Save: 
 Select this button to launch an operating system Save dialog to save the work currently in progress for 
the active window.  If the project has been previously saved, then the Save dialog will not appear.  It 
will simply save the changes made.  The keyboard shortcut is Ctrl + S (z + S).

Print: 
 Select this button to launch an operating system Print dialog box which will print a paper copy of the 
work piece (see Board and Manipulation for more information).  This can also be accessed using the 
keyboard command Ctrl + P (z + P).

Undo: 
 Select this button to undo the last edit operation. The CarveWright Designer records for multiple 

changes made to a project that can be undone.  They can also be undone by pressing Ctrl + Z (z + Z)

Redo: 
 Select this button to redo the last undone edit operation.  The CarveWright Designer records changes 

for multiple redos.  They can also be redone by pressing Ctrl + Y (z + Y)

Cut: 
 Select this button to remove the currently selected item(s) or carving(s) and place them onto the 

clipboard.  Pressing Ctrl + X (z + X) will cut the desired item as well.
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Copy: 
 Select this button to duplicate the currently selected item(s) or carving(s) onto the clipboard.  The 

keyboard shortcut for this feature is Ctrl + C (z + C)

Paste: 
 Select this button to paste the last item placed on the clipboard onto the board.  The keyboard shortcut 
for this function is Ctrl + V (z + V).

Cut/Copy/Paste within the CarveWright Designer Software�  Attempting to paste an item from another 
program may cause undesired effects�

Select all:
  This icon will select all items or carvings on the active board for the viewed side.  If there are items 
on the back of board while viewing the front of the board, the items on the back will not be selected.  
The keyboard shortcut for this command is Ctrl + A (z + A).

Delete: 
 Select this button to delete highlighted (selected) items from the active work piece.  This can also be 

accomplished by hitting the delete Ö button on the keyboard on either operating system’s keyboard.
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Startup Wizard

The Startup Wizard is the initial screen that displays to assist with common file options if the software is opened 
and there are no open files.  These features can also be accessed individually but are grouped on this screen to 
allow for quick access.

Figure 19�3�  Startup Wizard

To display or not to display, that is the question

The Startup wizard can be disabled by deselecting the check box next to Show on Startup�  
To re-enable the Startup Wizard, go to EditðPreferences and select the check box for Show 
Startup Wizard.  Once the software is restarted then the Startup Wizard will display again.

New Project
Selecting New Project does the same as selecting the new project icon from the standard toolbar or going to 
FileðNew.

Last Project
Clicking Last Project opens whatever the previous project was that was opened before the software was closed.  
Example:  If projects A, B, and C are all saved on the same computer, and B was the last project opened then B 
will open when selecting this option�  To see a list of the most recent opened projects and their locations, go to 
FileðOpen Recent�

Open Project
Open Project does the same as the open piece/project icon on the Standard Toolbar.  This option can also be 
accessed by pressing Ctrl + O (z + O) or go to FileðOpen.

Documentation
Selecting the Documentation option opens the Help Contents of the software.  There are search and bookmark 
tabs that can be used to quickly navigate to support information.  HelpðHelp Contents will open this feature.
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Chapter 20:  Manage Licenses

This chapter will illustrate the various items that are available under the Manage Licenses menu option of the 
Help Menu.

  This menu option has been updated since version 1�124 
but operates in a similar manner�  This section is being 
from written from the 1�132 version software�

The Manage Licenses Menu option allows a user to see the licenses installed on the current computer for the 
CarveWright Designer Software as well as the ability to activate newly acquired features.  Some the capabilities 
require an internet connection.  This menu option is explained in more details in the Manage Licenses Chapter.

Figure 20�1�  Manage Licenses (Your Licenses Dialog)

Under the patterns tab, if the warning message below is shown, updating the licenses (next section) will remove 
the warning.  The message is showing because the software has been updated to a version of the software later 
than 1.131 but the license information is still in the style of a version of the software older than 1.132.

You have uncategorized (old) Licenses, which are shown in red.  Click Update Licenses to connect.
Figure 20.2.  Old License Notification Display

Topics:
•  Update Licenses
•  Activate Licenses
•  Import License File
•  Activate Subscription
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Update Licenses

For computers connected to the internet (high-speed or dial-up connection), the software can connect with the 
online customer account and retrieve any licenses that have been activated to the online customer account.  
This is provided the Computer IDs match, the username is correct and the password is correct.  The ‘Update 
Licenses’ button displays the Registration - Account dialog.

Figure 20�3�  Registration - Account dialog

The check box for ‘Remember Login’ will retain the username and password (shown in asterisks) so the user 
will not have to enter the information the next time it is prompted for.  The ‘Connect without prompting (when 
needed)’ option will skip screens like this if the username and password entered are correct.  If the username 
and/or password is incorrect, the user will be brought back to this screen to correct the error.

Once all the information has correctly been entered, the ‘Next’ button will send the information to the customer 
account.  Any items that have already been activated on the account to currently used computer Id will activate 
automatically.  If there are any items that are on account that have not been activated to the computer then 
the user will be prompted with the available licenses.  Place a check in any of the check boxes that need to be 
activated and the ‘Next’ button will send the information back to the customer account for retrieval.

Figure 20�4�  Example Available License
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License Usage

Once licenses are applied to a computer, they can not be revoked.  Consumer 
licenses allow pattern or feature licenses to be installed on up to 2 computers.  in some 
cases, CarveWright allows licenses to be moved to other computers on an account, but 
this requires a call to customer service.

The software will ask for a confirmation password before allowing the newly added item licenses to the 
computer.  The confirmation password is the customer account password.

Figure 20�5�  Registration - Confirm License Selections

Once the information is entered password confirmation field, then the ‘Next’ button will become available.  If 
the information entered is correct then a successful registration will be displayed, otherwise the software will 
prompt for the correct confirmation password again.

Figure 20�6�  Registration - Thank You dialog (Successful Activation)

Once  successful, the ‘Finish’ button on the Registration - Thank You dialog will close the dialog and display 
the Your Licenses dialog where the new items can be seen.
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Activate Licenses

The software that comes with the CarveWright/CompuCarve Woodworking Machine is enough to accomplish 
many projects, but there will come a time when more is desired out of the CarveWright Designer Software.  
Any premium feature, pattern, pattern collection or project that is purchased from the CarveWright website or 
authorized retailer of such features will have a 16 character serial code.  

Figure 20�7�  Example Serial Code

Note:  Always verify the following when entering any serial code into the software:

* Letters and numbers are correct
* The letters are capitalized
* The dots are in place
* There are no spaces or symbols

The ‘Activate Licenses’ button allows for activation of a serial code that has not been previously activated to the 
customer account.  Click the “Activate Licenses” button to display the “Registration” dialog box .

There are two methods for activation.  The first method is ‘License Online Now’, which requires the computer 
be directly connected to the internet.  The other method, ‘License at www.carvewright.com from another 
computer’  is for computers that are not directly connected to the internet but the user has access to the internet 
at another computer.

Figure 20�8�  Registration dialog - Choose Registration Method
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Online Method

For the online method, the serial number provided will need to be available (Figure 18.3) as well as the 
username and password for the customer account (a space was provided for this information at the end of 
chapter 2).  

Figure 20�9�  Registration Dialog

The check box for ‘Remember Login’ will retain the username and password (shown in asterisks) so the user 
will not have to enter the information the next time it is prompted for.  The ‘Connect without prompting (when 
needed)’ option will skip screens like this if the username and password entered are correct.  If the username 
and/or password is incorrect, the user will be brought back to this screen to correct the error.

Once all the information has correctly been entered, the ‘Next’ button will send the information to the customer 
account.  When successfully activated to the customer account and computer, a confirmation will display on 
the screen stating the additional software licensing was successful.  If unsuccessful, then the prompted for  
information will need to be corrected.

Figure 20�10�  Registration - Thank You dialog (Successful Activation)

The ‘Finish’ button will close the dialog and display the your licenses where the new license can be seen.



166

Chapter 20:  Manage Licenses
License using Another Computer Connected to the Internet

For computers not connected to the internet, a display will provide information on how to activate the software 
to the account as well as the computer using another computer.  This process still requires an internet connection 
but it does not have to be connected to the computer where the software is installed.

Figure 20�11�  Registration - Get License File Dialog

To license additional software using another computer, use a web browser to log in to your customer account at 
http//:www.carvewright.com/register.

Figure 20�12�  Customer Account Login (Web)

Enter the software serial code in the field under ‘Enter Activation ID or Serial Number Here’ followed by the 
‘Activate New’ button.

Figure 20�13�  Online Software Activation
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The new item will now be available to be applied to a computer.  Under the appropriate section, will be the 
new add-on.  The item that was added was a pattern, collection, or project, there will be a link next to each one 
respectively so that the needed files can be downloaded.  Once all the necessary files are downloaded, towards 
the bottom of the screen will  be two links.  The link needed for this instance is the one marked ‘Download 
License File’.

Figure 20�14�  Online Account - Subscription sub-section

Save this file to a removable media device and take the file back to the computer where the software is installed.  
Click the ‘Import License File’ button display the Open dialog.  Navigate to the removable media that contains 
the license file and click the ‘Open’ button.

Figure 20�15�  Open dialog

The software will display a successful screen, if the process went through, or prompt for additional information 
if unsuccessful. 
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Figure 20�16�  Registration - Successful Activation

Once the ‘Finish’ button is clicked, all the licenses that were imported will be viewable from the Your licenses 
dialog.
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Import License File

For computers not connected to the internet, it is possible to get the licenses from the internet installed on to 
the computer that is not connected to the internet.   From a computer connected to the internet, go to www.
carvewright.com/register to login in to the customer account.  Here all the account information can be seen.  
Towards the bottom of the screen will  be two links.  The link needed for this instance is the one marked 
‘Download License File’.

Figure 20�17�  Online Customer Login - Download License File

Save this file to a removable media device and take the file back to the computer where the software is installed.  
Click the ‘Import License File’ button display the Open dialog.  Navigate to the removable media that contains 
the license file and click the ‘Open’ button.

Figure 20�18�  Open dialog
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The software will display a successful screen, if the process went through, or prompt for additional information 
if unsuccessful. 

Figure 20�19�  Registration - Successful Activation

Once the ‘Finish’ button is clicked, all the licenses that were imported will be viewable from the Your licenses 
dialog.
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Activate Subscription

The code needed to activate Subscriptions will come in one of two different methods.  It will either come in 
the packaging or in an e-mail from the store purchase.  The Subscription can not be activated to the customer 
account without this 16 character code.  

Figure 20�20�  Subscription of the Month E-mail

Click the ‘Activate Subscription’ button to display the ‘Registration.  There are two methods for subscription 
activation.  The first method is ‘License Online Now’, which requires the computer be directly connected to the 
internet.  The other method, ‘License at www.carvewright.com from another computer’  is for computers that 
are not directly connected to the internet but the user has access to the internet at another computer.

Figure 20�21�  Registration dialog - Choose Registration Method
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Online Method

For the online method, the serial number provided will need to be available (Figure 18.3) as well as the 
username and password for the customer account.

Figure 20�22�  Registration - Register Subscription dialog

The check box for ‘Remember Login’ will retain the username and password (shown in asterisks) so the user 
will not have to enter the information the next time it is prompted for.  The ‘Connect without prompting (when 
needed)’ option will skip screens like this if the username and password entered are correct.  If the username 
and/or password is incorrect, the user will be brought back to this screen to correct the error.

Once all the information has correctly been entered, the ‘Next’ button will send the information to the customer 
account.  When successfully activated to the customer account and computer, a confirmation will display on 
the screen stating the additional software licensing was successful.  If unsuccessful,  then the prompted for  
information will need to be corrected.

Figure 20�23�  Registration - Subscription Registered dialog (Successful 
Subscription Activation)

The ‘Finish’ button will close the dialog and display the ‘Your Licenses’ dialog.  The first project of the month 
should be e-mailed to the e-mail address on the customer account about 30 minutes after successful subscription 
activation.  It is a good idea to log in to the customer account online and verify that the e-mail address is correct.  
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License using Another Computer Connected to the Internet

For computers not connected to the internet, a display will provide information on how to activate the software 
to the account as well as the computer using another computer.  This process still requires an internet connection 
but it does not have to be connected to the computer where the software is installed.

Figure 20�24�  Registration - Get License File Dialog

To license additional software using another computer, use a web browser to log in to your customer account at 
http//:www.carvewright.com/register.

Figure 20�25�  Customer Account Login (Web)

Enter the subscription serial code in the field under ‘Enter a subscription activation code here’ followed by the 
‘Claim Subscription’ button.

Figure 20�26�  Online Subscription Activation
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At the bottom of the screen will be a section that shows the subscription information after a successful 
subscription activation.  This section will show when the Subscription was activated (not purchased) and how 
many units left on the subscription.  The automated process takes about 30 minutes before the first project is 
received.  The first issue that will be received is the last project issued.

Figure 20�27�  Online Account - Subscription sub-section

Once the e-mail is received, follow the instructions for importing a license stated earlier in the chapter.  The 
Subscription of the Month can only be activated to one customer account and is non-transferable.  The 
subscription start from the date of activation.  It is not possible to pick and choose which months are desired.
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Chapter 21:  Toolbar Customization

Customization
Toolbars offer a quick way of accessing tools and functions. The toolbars can be moved around as desired. 
They can even be separated out as separate windows. Right clicking anywhere in the toolbar area will open a 
dialog showing all of the toolbars available. The toolbars that are displayed will have a check next to them. Left 
clicking on the toolbars in the list will open or close it depending on its current state.

Figure 21�1�  Toolbar Context Menu

 At the bottom of the dialog are two functions: Line Up, which lines up the toolbars displayed and Customize, 
which opens the Customize Toolbars dialog.

Topics:
•  Customization
•  Toolbar Options
•  Add\Remove Icons
•  Reset
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Figure 21�2�  Customize Toolbars Dialog Box

Toolbar Options
Large Icons

The “Use Large Icons” checkbox under the Toolbar Options section will make the icons larger for easier 
viewing.  This will affect all icons on the toolbars.  This option does not affect the mouse pointer.

  >  

Figure 21�3�  Small to Large icons

Labels
The “Show Icon Labels” checkbox under the Toolbar Options section will place the name under a icon.  This 
allows easy identification of the icons.  This option affects all icons on the toolbars.  This option does not affect 
the mouse pointer.

  >  

Figure 21�4�  Icon w/o Label & Icons w/Labels
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Add\Remove Icons

At the top of Customize Toolbars Dialog Box is a Toolbar Dropdown List.  The currently selected Toolbar can 
be modified to put whatever feature desired in the selected Toolbar.  The left colum or the Seledted Items list 
displays the icons currently in the selected toolbar.  The right column or the Available Items list displays all 
the icons not currently in the selected toolbar.  Each icon can only be used once, however the seperator can be 
used multiple times.  The seperator will place a horizontal line between the icons you designate to provide more 
sectioning within the selected toolbar.  Any tool or function can be dragged into or out of any tool bar. 

Reset
Any changes that have been made to the Toolbars can be reset to the default by clicking the Reset button.  This 
will only affect the currently selcted Toolbar.  In order to reset each toolbar, each toolbar will need to be selected 
and then click the reset button.
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Chapter 22:  Software Removal
In the event the software needs to be removed, locate the corresponding Operating System in the list below and 
follow the appropriate instructions. :

Topics:
•  Microsoft® Windows® XP SP 2, Windows® 2000
•  Windows™ Vista
•  Mac OS® X ver. 10.4 or later

Once you have determined which operating system is being used, use the corresponding removal instructions in 
the following sections.

Note:  The software can not be running when uninstalling the software.

Microsoft® Windows® XP SP 2, Windows® 2000
From the Start Menu, click on the Control Panel Icon.
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The Control Panel may be shown in different manners based on the computer configuration but the required 

icon is ‘Add or Remove Programs’.  
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On the Add or Remove Programs dialog, locate the list entry for the CarveWright Designer Software.  Click on 
it to see the ‘Change’ and ‘Remove’ buttons.  Select the ‘Remove’ button.

If prompted for confirmation to remove the software, select the ‘Yes’ button to confirm or the ‘No’ button to 
cancel the software removal process.

The status of the removal will show on the screen.  There will be no confirmation of the software removal.
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Windows™ Vista

From the Start Menu, click on the Control Panel Icon.
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The Control Panel may be shown in different manners based on the computer configuration but the required 

icon is ‘Uninstall a Program’.
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On the ‘Uninstall or change a program’ dialog, locate the list entry for the CarveWright Designer Software.  
Right-click on it and choose the Uninstall option from the context menu or select the ‘Uninstall’ button at the 
top of the list programs.

If prompted for confirmation to remove the software, select the ‘Yes’ button to confirm or the ‘No’ button to 
cancel the software removal process.

The status of the removal will show on the screen.  There will be no confirmation of the software removal.
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Mac OS® X ver. 10.4 or later

  

The applications folder is where most of the programs on a Mac system are kept. It can 
be accessed through Macintosh HD (default name). 

  

Drag this icon from the 
Applications folder or the 
location that you chose to 
store the application in to 
the trash can.
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Appendix A:  Toolbar Quick 
Reference
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File and Edit Menus

New Piece/Project:
Select this button to launch the New Dialog to create a new piece or project.

Open Piece/Project:
Select this button to launch an operating system File Open Dialog to recall a piece or project 
previously saved to disk.

Save:
Select this button to launch an operating system Save Dialog to save a work currently in progress

Import Image:
Select this button to import an image into your pattern library

Upload:
Select this button to upload a project to the flash card

Print:
Select this button to print a paper copy of the work piece

Undo:
Select this button to undo the last edit operation.

Redo:
Select this button to redo the last undone edit operation.

Cut:
Select this button to cut the currently selected carvings or figures and place them onto the clipboard.

Copy:
Select this button to copy the currently selected carvings or figures onto the clipboard.

Paste:
Select this button to paste any carvings or figures currently on the clipboard onto the board

Select all:
Select this button to select all items on the board

Delete:
Select this button to delete highlighted items from the work piece



189

CarveWright Designer Software Manual
Drawing Menu

Pointer Tool:
Select this tool, then left-click on the board to select carvings for manipulation. You may hold down 
the SHIFT key to select or de-select additional carvings. You may also click and drag to draw a wire-
box to select multiple carvings.

Line Segment Tool:
Select this tool, then left-click on the board to begin a line segment. Left-click again to end it. You 
may also click and drag to create a segment.

Connected Lines Tool:
Select this tool, then left-click on the board to begin a line segment. Each successive left click ends 
the previous segment and begins a new one. To end the segments, you may either double-click to 
place a final segment, click on the last vertex placed, press the ESC key, or click on the first vertex 
to create a closed loop.

Spline Tool:
Select this tool, then left-click on the board to begin a curved segment. Each successive left click 
ends the previous segment and begins a new one. You need to create two or more connected 
segments to see the curve effect. To end the segments, you may either double-click to place a final 
segment, click on the last vertex placed, press the ESC key, or click on the first vertex to create a 
closed loop.

Square Tool:
Select this tool, then left-click on the board to start a square, and then left-click again to end it. 
You may also click and drag to create a square. Squares will maintain their square aspect when 
manipulated.

Rectangle Tool:
Select this tool, then left-click on the board to start a rectangle, and then left-click again to end it. You 
may also click and drag to create a rectangle.

Circle Tool:
Select this tool, then left-click on the board to place the center of the circle, then left-click again to 
end it. You may also click and drag to create a circle. Circles will maintain their circular aspect when 
manipulated.

Oval Tool:
Select this tool, then left-click on the board to place the center of the oval, then left-click again to end 
it. You may also click and drag to create an oval.

Arc Tool:
Select this tool, then left-click on the board to place one end of the arc, then left-click to place the 
other end. You may also click and drag to create an arc. Either way you need to click and drag the 
Green Control Point to change the radius of the arch.

Spiral Tool:
Select this tool, then left-click to place a spiral. It may then be manipulated by dragging the yellow 
border to widen the loops or by dragging its vertices to set the starting and ending loops.
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Sine Tool:
Select this tool, then left-click to place a sine wave. It may then be manipulated by dragging the 
yellow border to widen or lengthen the loops. You may also click and drag its vertices to set the 
starting and ending loops

Text Tool:
Select this tool, then left-click to place text. See Placing Text for more information.

Carving Menu

Pattern Tool:
Selecting this tool will display the pattern selection window. Select a pattern from the list, view it 
in the thumbnail view window beneath the pattern list, and then left-click on the board to place the 
pattern. See the Placing Patterns section for more information

Feather:
This sets the degree of feathering applied to the highlighted pattern on the work piece

Merge:
This sets the conditions on how patterns or surfaces overlap one another.

Clip Carving:
Clip Pattern can be used to eliminate a portion of a pattern

Bit Optimization:
Increases both the quality of the carving and the time it takes to run

Invert Pattern:
This button toggles the invert mode for patterns, which reverses the direction of the artwork

Layout Menu

Center:
Selecting this will center the pattern with respect to the X-axis, Y-axis, or both
Layout Menu

Align:
Aligns multiple features with respect to one another along the selected orientation

Mirror:
Creates a copy of the selected feature(s) about the horizontal, vertical, or diagonal axis.

Flip & Rotate:
Flips the highlighted feature(s) with respect to the horizontal and vertical axis, or rotates the 
highlighted feature(s) with respect to their midpoint

Group:
Groups multiple features together as one.
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Tools Menu

Drill Tool:
Select this tool, then left-click to place the hole. A dialog box will appear, asking for the diameter and 
depth of the hole

Edge Rout:
This button launches the Edge Rout Dialog, allowing you to select a bit for edge routing the work 
piece

Carve Region:
This mode creates a region inside closed figures, which is a flattened area to which a surface or 
pattern may be applied.

Select Surface:
This allows the user to apply a surface, other than flat, to a carved region

Select Texture:
This allows the user to apply a texture to a carved region

Select Bit:
This button launches the Select Bit dialog, allowing you to select a bit or macro to apply along the 
path of the selected figure.

Select Depth Profile:
This button launches the Select Depth Profile dialog, allowing you to select a carving cut profile to 
apply along the path of the selected figure.

Reverse Depth Profile:
This button reverses the profile set under Select Depth Profile

Cut Path:
This tool cuts through the board along the selected path

Flip Cutout:
This flips the cut to the other side of the line chosen in Cut Path

Hide Cutout:
This hides the work piece on the cut side of the line chosen in Cut Path

Outline Pattern(s):
This outlines the path of a geometric figure in which a bit can be applied

Edit Text:
Takes you to the Text Tool dialog box for the highlighted text
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View Menu

Render Quality:
For performance reasons, the piece is normally displayed in a lower-quality format while being 
manipulated, and then redisplayed in a high quality format after all manipulation has ceased. Click 
this option to disable this feature, or click the drop-down button for a list of rendering quality 
settings. Faster machines with good graphics cards may be able to turn off auto-render and run with 
the highest “++” quality setting

Lighting Direction:
Clicking this option allows you to change which direction the light is shining on the board, thus 
changing the shadows on the board

Toggle Auto Re-Render:
For performance reasons, the piece is normally displayed in a lower-quality format while being 
manipulated, and then redisplayed in a high quality format after all manipulation has ceased.

Toggle Perspective View:
Click this option to toggle between perspective and orthographic view of the currently displayed 
piece. Perspective view applies a natural depth perspective to the 3D rendering, whereas orthographic 
view does not

Rotate Tool:
Select this tool, then position the mouse over the board. Now hold down the left mouse button and 
move the mouse to rotate the board to the desired view. TIP: An alternate method for rotating the 
board is to hold down the SHIFT key and the middle mouse button while rotating the board with the 
mouse.

Pan Tool:
Select this tool, then position the mouse over the board. Now hold down the left mouse button and 
move the mouse to pan/move the board. TIP: An alternate method for panning the board is to hold 
down the SHIFT key and the right mouse button while panning the board with the mouse.

Zoom Tool: Select this tool, then position the mouse over the board. Left-click the mouse to zoom 
in and right-click the mouse to zoom out. TIP: An alternate method for zooming in and out is to hold 
down the SHIFT key and the left mouse button while zooming in and out with the mouse

Front View:
Click this button to re-orient the currently displayed piece to its front face.

Rear View:
Click this button to re-orient the currently displayed piece to its rear face

Isometric View:
Click this button to re-orient the currently displayed piece to an isometric front view. This angle of 
rotation is convenient for viewing three-dimensional carvings

Square Board:
Click this button to re-orient the work piece to the most prominent surface displayed
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Toggle Texture:
Clicking this option toggles wood-grain texture for the currently displayed piece. Some carvings are 
easier to visualize without the grain, but the grain gives you a better idea what the finished piece will 
look like

Toggle Construction Lines:
Clicking this option toggles the display of dashed construction lines, which include the board 
centerlines and the dashed lines of geometric figures that have not been assigned a cut profile

Toggle Grid Lines:
Clicking this option toggles the grid lines.

Toggle Labels:
Clicking this option toggles the display of all constraint labels, which indicate distances from carving 
vertices to board edges and centerlines. See Setting Attachments for more information.

Carving List:
Click this button to display a tree of the features added to the work piece.
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Problem Possible Issue

Will not connect to the internet from within 
the program

Not connected to the internet, ensure that your computer’s internet 
connection is still active

Your computer’s Firewall or internet firewall is preventing access to the 
internet.
A Default internet browser has not been defined, and the software does not 
know how to connect.  Check the deafult internet browser for the computer
Our Server may be down for maintenace.  Check the website for 
information.

Flash Card will not initialize

Programmer and/or Memory Card is not inserted

The Programmer is not recognized by the computer

The Memory Card or the Programmer is bad

Multiple libraries The MPN file associated with the library has been duplicated, remove the 
duplicates

Software Crashes [Windows Vista]

The software was not installed properly (see Software Installation, 
Microsoft® Windows® on page 14)
Some Windows operating systems running 64 bit  require the render cache 
to be increased to 256 MB

Pattern will not move on screen Remove attachment points
Turn off Center options

Number box is locked on screen Hit ‘Esc” key on keyboard to cancel or ‘Enter” key to accept
Program flashes will not proceed 
[Windows XP]

The WMI for the operating is not operating correctly, contact the computer 
manufacturer

Half the board the board is displayed on 
screen On the View menu, turn off the Toggle Auto Re-render option
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Conversion Table
.015625 1/64 .515625 33/64
.03125 1/32 .53125 17/32
.046875 3/64 .546875 35/64
�0625 1/16 �5625 9/16

.078125 5/64 .578125 37/64
.09375 3/32 .59375 19/32
.109375 7/64 .609375 39/64

�125 1/8 �625 5/8
.140625 9/64 .640625 41/64
.15625 5/32 .65625 21/32
.171875 11/64 .67185 43/64
�1875 3/16 �6875 11/16

.203125 13/64 .703125 45/64
.21875 7/32 .71875 23/32
.234375 15/64 .734375 47/64

�25 1/4 �75 3/4
.265625 17/64 .765625 49/64
.28125 9/32 .78125 25/32
.296875 19/64 .796875 51/64
�3125 5/16 �8125 13/16

.328125 21/64 .828125 53/64
.34375 11/32 .84375 27/32

.359375 23/64 .859375 55/64
�375 3/8 �875 7/8

.390625 25/64 .890625 57/64
.40625 13/32 .90625 29/32
.421875 27/64 .921875 59/64
�4375 7/16 �9375 15/16

.453125 29/64 .953125 61/64
.46875 15/32 .96875 31/32
.484375 31/64 .984375 63/64

�50 1/2 1�00 1

Common conversions are in bold and highlighted

The software will only accept up to three decimal places



201

CarveWright Designer Software Manual

Appendix D:  Premium Features



202

Appendix D:  Premium Features
This appendix briefly covers the premium features that can be purchased for the CarveWright Designer 
Software.  For more information on these premium features and more, go to the CarveWright website www.
carvewright.com.

  The software version must be 1�123 or later in order to 
activate the premium features in this appendix�

Centerline
The Centerline Text premium feature adds an additional Rout Mode for the Text Tool feature.  This premium 
feature is designed specifically for use with the 60° and 90° V-groove bits which carve text with pin-point 
accuracy.  Centerline text carves point-to-point in vector mode following the center of the letter.  The depth 
of the centerline is determined by the width of the text selected. Multiple licenses can be purchased for use on 
multiple systems. 

Benefits: 
•  Fastest carving of text as it follows the path of the text 
•  Ability to carve small text regardless of grain of material 
•  Uniquely different aesthetic effect compared with the raster mode  

This bit or that bit

90 degree and/or 60 degree V-Bits required for proper Centerline Text function.  The 
software will show what the cut will look like with the selected bit but the machine will 
also be utilizing that bit.  It is not possible to re-create one bits carve with another bit.  
Using other than the bit called can break bits as well as cause damage to the machine.

Use of the Centerline Text feature is not explained in this book.

For instructions on how to activate premium features, see “Activate Licenses” on page 164.  If the license has 
already been activated to the customer account, then see “Update Licenses” on page 162 on how to activate the 
license to an additional computer.

http://www.carvewright.com
http://www.carvewright.com
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Pattern Editor

The Pattern Editor Software, which is normally supplied with the CarveWright Scanning Probe, can also be 
purchase independent of the probe.  The Pattern Editor Software allows the manipulation of a scanned or 
imported image on a pixel by pixel level basis. The premium feature has the following features: 

Benefits:
•  Visual 3D image display efficient real time editing 
•  Ability to edit images at the pixel level 
•  Tools for Painting, Erasing, Blurring, Filling, Sampling 
•  Filters that Raise/Lower, Smooth, Blur the surface 

The features of the program are not explained in this book.

For instructions on how to activate premium features, see “Activate Licenses” on page 164.  If the license has 
already been activated to the customer account, then see “Update Licenses” on page 162 on how to activate the 
license to an additional computer.

STL Importer

The Pattern Editor Software, which is normally supplied with the CarveWright Scanning Probe, can also be 
purchase independent of the probe.  The Pattern Editor Software allows the manipulation of a scanned or 
imported image on a pixel by pixel level basis. The premium feature has the following features: 

Benefits:
•  Visual 3D image display efficient real time editing 
•  Ability to edit images at the pixel level 
•  Tools for Painting, Erasing, Blurring, Filling, Sampling 
•  Filters that Raise/Lower, Smooth, Blur the surface 

The features of the program are not explained in this book.

For instructions on how to activate premium features, see “Activate Licenses” on page 164.  If the license has 
already been activated to the customer account, then see “Update Licenses” on page 162 on how to activate the 
license to an additional computer.

DXF Importer

The Pattern Editor Software, which is normally supplied with the CarveWright Scanning Probe, can also be 
purchase independent of the probe.  The Pattern Editor Software allows the manipulation of a scanned or 
imported image on a pixel by pixel level basis. The premium feature has the following features: 

Benefits:
•  Visual 3D image display efficient real time editing 
•  Ability to edit images at the pixel level 
•  Tools for Painting, Erasing, Blurring, Filling, Sampling 
•  Filters that Raise/Lower, Smooth, Blur the surface 
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The features of the program are not explained in this book.

For instructions on how to activate premium features, see “Activate Licenses” on page 164.  If the license has 
already been activated to the customer account, then see “Update Licenses” on page 162 on how to activate the 
license to an additional computer.

Conforming Vectors

Conforming Vectors is an advanced feature available for use with your Project Designer Software. Apply 
Centerline Text and all other vector cutting to a carved region or virtually any surface, whether domed or 
textured; even patterns. It can be any vector cut such as those done with our drawing tools, the Outline and 
Centerline Text and vectors brought in through DXF Importer.

Benefits:
•  Carves the vector to the shape of the surface

The features of the program are not explained in this book.

For instructions on how to activate premium features, see “Activate Licenses” on page 164.  If the license has 
already been activated to the customer account, then see “Update Licenses” on page 162 on how to activate the 
license to an additional computer.
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Appendix E:  Glossary
BIOS ................................................................................... 190
BMP (Bitmap) .................................................................... 190
Caps Lock ............................................................................ 190
Click .................................................................................... 190
Context Menu ..................................................................... 190
Control Panel [Windows Operating System] ...................... 190
Desktop ............................................................................... 190
DMG (Disk Iamge) ............................................................. 191
Double-click ........................................................................ 191
such as a menu command, an icon, or a button.  ................. 191
Drag .................................................................................... 191
EXE (Executable) ............................................................... 191
Export ................................................................................. 191
File Extension ..................................................................... 191
Firewall ............................................................................... 191
Firmware ............................................................................. 191
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GIF (Graphical Interchange Format) ................................. 191
GUI (Graphical User Interface) ......................................... 191
Import ................................................................................. 192
JPEG (Joint Photographic Experts Group) ........................ 192
MNG (Multiple-image Network Graphics) ........................ 192
OpenGL ............................................................................... 192
Password ............................................................................. 192
PCMCIA ............................................................................. 192
PDF (Portable Document Format) ..................................... 192
PNG (Portable Network Graphics) ..................................... 193
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System Tray [Windows Operating Systems] ....................... 194
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Username   .......................................................................... 194
XPM (XPixMap) ................................................................. 195
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BIOS
 BIOS (basic input / output system) is basically the “software” the computer uses for it’s most basic op-
erations (accessing memory, disks, processors, etc.). This “software” is built into the computer’s motherboard, 
so don’t worry about losing it if your hard drive crashes.
 Note that these are NOT Windows settings, these are the “core” settings for your computer. You normal-
ly can get at them by pressing the DEL key a few seconds after you turn your computer on (this can vary from 
machine to machine though). 
 Most BIOS setups allow you to configure hard drive parameters, set the time, type of floppy disk drives, 
memory timing, and so on. It’s probably an area that’s best left alone unless you are an experienced computer 
user. I’ve seen more than one computer that was rendered useless from tampering with these settings.

BMP (Bitmap)
 The BMP format is a commonly used raster graphic format for saving image files. The BMP format 
stores color data for each pixel in the image without any compression. For example, a 10x10 pixel BMP image 
will include color data for 100 pixels. This method of storing image information allows for crisp, high-quality 
graphics, but also produces large file sizes. The JPEG and GIF formats are also bitmaps, but use image com-
pression algorithms that can significantly decrease their file size. For this reason, JPEG and GIF images are used 
on the Web, while BMP images are often used for printable images.

Caps Lock
 Caps lock is a feature nearly all keyboards have that, when active, capitalizes each letter typed on the 
keyboard. Unlike most keys on the keyboard, the caps lock key is a “toggle key,” which is always in either an 
on or off position. When off, the letters typed are input like usual. When on, each letter typed is transmitted as 
an upper-case character. Caps lock does not alter the input from the rest of the keys, such as numbers and sym-
bols.

Click
 Quickly press and release the left mouse button while the mouse pointer is on an
object, such as a menu command, an icon, or a button.

Context Menu

Control Panel [Windows Operating System]
 The Control Panel is a feature of the Windows operating system that allows the user to modify system 
settings and controls. It includes several small applications, or control panels, that can be used to view and 
change hardware or software settings. The Control Panel can be accessed by clicking the Start menu and select-
ing Control Panel. It is also available in the “Other Places” section of the window’s sidebar when you open My 
Computer. In Windows XP and Windows Vista the Control Panel can be viewed in either Category View or 
Classic View. Category View arranges the control panels into sections, while Classic View shows them all at 
once. While the Category View is designed to make locating different settings easier, people familiar with most 
of the control panels often find the Classic View more efficient.
 Control Panels were also used for many years by the Mac OS, through Mac OS 9. However, with the 
introduction of Mac OS X, control panels were consolidated into a single interface called System Preferences. 
The control panels themselves are now called “Preference Panes” in Mac OS X. They can be accessed by select-
ing “System Preferences” from the Apple menu or by clicking the System Preferences icon in the Dock.

Desktop
 The Desktop, basically, is where all your icons live (stuff like the Recycle Bin sit on the Desktop). It’s 
the “background” area you see when your computer first boots up before you run any programs.
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DMG (Disk Iamge)
 Disk image (file extension for Mac computer)

Double-click
 Quickly click the left mouse button twice while the mouse pointer is on an object,

such as a menu command, an icon, or a button. 

Drag
 Move the mouse pointer to an object, press and hold the left mouse button while
moving the mouse, and then release the button.

EXE (Executable)
 Executable file (file extension for Windows based computer installation)

Export
 To format data so that it can be read and used by another application, thereby allowing multiple pro-
grams to share the same data. Data can be exported and imported between word processing programs, differ-
ent types of graphics programs, or different types of applications altogether (such as a database program and 
a spreadsheet program). The export feature is under the File menu in most programs; go to it from within the 
program you want to export out of and you’ll find a list of supported programs or file formats for exporting. 

File Extension
 A file extension is the suffix at the end of a filename indicating what type of file it is.

Firewall
 A firewall refers to either a software or hardware device that basically protects your internal network 
from any outside threat or any unauthorized Internet access from the inside.

Firmware
 Firmware is a software program or set of instructions programmed on a hardware device. It provides the 
necessary instructions for how the device communicates with the other computer hardware. But how can soft-
ware be programmed onto hardware? Good question. Firmware is typically stored in the flash ROM of a hard-
ware device. While ROM is “read-only memory,” flash ROM can be erased and rewritten because it is actually 
a type of flash memory.

Fonts
 A font is a specific typeface of a certain size and style. For example, one font may be Arial 12 pt bold, 
while another font may be Times New Roman 14 pt italic. Most word processing programs have a Font menu 
that allows you to choose the typeface, size, and style of the text. In order to use a font, you must have it in-
stalled on your computer. Windows provides access to fonts using the Fonts control panel. The Mac OS stores 
fonts in a Fonts folder and includes a separate “Font Book” application for managing fonts.

GIF (Graphical Interchange Format)
 A widely used format for storing compressed (lossless) graphics for use on the Internet and elsewhere. 
(See JPEG.) [Note: There are some GIF formats that are not lossless. Be certain you know which your graphics 
software produces.]

GUI (Graphical User Interface)
 If you can push buttons, scroll scrollbars, or interact with any kind of non-text element on a page, you’re 
using a GUI.
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Import
 The ability of one application to use data produced by another application. For example, many programs 
are able to import graphics in a variety of formats. The import feature is under the File menu in most programs; 
it will show you a list of programs that are recognized for importing data. In other applications, such as a data-
base program, an import window may appear giving you the option to select the location of the document to be 
imported and to select from a list of file formats. 

JPEG (Joint Photographic Experts Group)
 An image compression specification named for the group that created it. While extensive compression 
is available, the JPEG specification is lossy (data is lost during the compression process). Therefore one should 
not recompress JPEG compressed images. Work from the original and compress that each time. JPEG works 
better for real-world scenes; line drawings are better compressed using some other format.

MNG (Multiple-image Network Graphics)
 A variation on the PNG standard which basically allows multiple images in a single graphic file, thus 
providing for animation.

OpenGL
 A 3D graphics language developed by Silicon Graphics. Before OpenGL was available, software de-
velopers had to write unique 3D graphics code for each operating system platform as well as different graphics 
hardware. However, with OpenGL, developers can create graphics and special effects that will appear nearly 
identical on any operating system and any hardware that supports OpenGL. This makes it much easier for de-
velopers of 3D games and programs to port their software to multiple platforms.

Password
 A string of characters used for authenticating a user on a computer system. For example, you may have 
an account on your computer that requires you to log in. In order to successfully access your account, you must 
provide a valid username and password. This combination is often referred to as a login. While usernames are 
generally public information, passwords are private to each user.

PCMCIA
 Stands for an association founded in 1989 which develops standards for expansion cards for portable 
computers. However, the term is most commonly associated with the actual cards standardized by the organiza-
tion. These cards are referred to as “PCMCIA cards,” or simply “PC cards.” There are three types of PCMCIA 
cards, all of which are rectangular and measure 8.56 by 5.4 cm., but have different widths:

Type I: up to 3.3 mm. thick, mainly used to add additional ROM or RAM. 
Type II: up to 5.5 mm. thick, typically used for fax/modem cards. 
Type III: up to 10.5 mm. thick, often used to attach portable disk drives. 

PCMCIA slots also come in three sizes -- a Type I slot can hold one Type I card, a Type II slot can hold one 
Type II card or two Type I cards, and a Type III slot can hold one Type III card or one Type I and one Type II 
card. PC Cards can be removed or inserted “on the fly,” which means you don’t have to turn your computer off 
to exchange them and you don’t have to restart for your computer to recognize them.

PDF (Portable Document Format)
 PDF is a fixed-layout electronic file format that preserves document formatting and enables file sharing. 
The PDF format ensures that when the file is viewed online or printed, it retains exactly the format that you in-
tended, and that data in the file cannot be easily changed. The PDF format is also useful for documents that will 
be reproduced by using commercial printing methods.
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PNG (Portable Network Graphics)
 A bitmap format designed to take the place of GIF. Unlike GIF, PNG is not tied to compression patents 
and licenses. PNG graphics have a sample depth of from 1 to 16 bits. Since PNG is designed for on-line view-
ing it is streamable and has a progressive display option. PNG also allows for storing color data for color match-
ing. The basic PNG specification, however, does not support animations.

Point
 Move the mouse pointer directly to a specific location, such as a menu command,
an icon, or a button.

Radio Button
 If you’ve ever needed to fill out information on any kind of web form, you’ve probably seen these. They 
look kind of like an “o” and are used to present you with a multiple choice selection. When you click them, they 
act like an old-time AM radio button. You select one and they rest are unselected.

RAM (Random Access Memory)
 The memory your computer uses to store information.  RAM chips store information electronically, so 
it’s must faster for the computer to put information into RAM memory than to write it to disk. Hence, the more 
RAM you have in your computer, the faster it tends to run.

Recycly Bin
The Recycle bin holds files that you delete, in case you need to get them back. It only holds a limited amount, 
so even if you never empty it, you won’t end up with a hard drive full of old, deleted files.

Registry
 Basically, the Windows registry is used to store system and program settings.

Render Cache
 Another common type of cache is a disk cache. This stores information you have recently read from 
your hard disk in the computer’s RAM, or memory. Since accessing RAM is much faster than reading data off 
the hard disk, this can help you access common files and folders on your hard drive much faster.
 Another type of cache is a processor cache which stores small amounts of information right next to the 
processor. This helps make the processing of common instructions much more efficient, thereby speeding up 
computation time.

Right-Click  
  Most computer mice have at least two mouse buttons. When you press the left one, it is called a left 
click. When you press the one on the right, it is called a right click. By default, the left button is the main mouse 
button, and is used for common tasks such as selecting objects and double-clicking.
 The right mouse button is often used to open contextual menus, which are pop-up menus that change 
depending where you click. For example, if you right click on the desktop, you may see a menu pop up that 
includes “Change View Options” and “Change Desktop Background.” If you right click on a folder, the menu 
might include options such as “Open” and “Properties.” Certain programs, such as video games, may use the 
right click to perform other functions, such as firing a secondary weapon in a first-person shooter. Most pro-
grams, however, use the right click to open contextual menus 

Scroll Bar  
  When the contents of a window are too large to be displayed entirely within the window, a scroll bar will 
appear. For example, if a Web page is too long to fit within a window, a scroll bar will show up on the right-
hand side of the window, allowing you to scroll up and down the page. If the page is too wide for the window, 
another scroll bar will appear at the bottom of the window, allowing you to scroll to the left and right. If the 
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window’s contents fit within the current window size, the scroll bars will not appear.
 The scroll bar contains a slider that the user can click and drag to scroll through the window. As you may 
have noticed, the size of the slider may change for different windows. This is because the slider’s size represents 
what percentage of the window’s content is currently being displayed within the window. For example, a slider 
that takes up 75% of the scroll bar means 75% of the content fits within the current window size. A slider that 
fills only 10% of the scroll bar means only 10% of the window’s contents are being displayed within the current 
window size. Therefore, if two windows are the same size, the one with the smaller slider has more content than 
the one with the larger slider.
 Most scroll bars also contain up and down or left and right arrows that allow the user to scroll in small 
increments by clicking the arrows. However, clicking and dragging the slider is much faster, so the arrow keys 
are typically not used as often. Also, some mice have a scroll wheel that allows the user to scroll by dragging 
the wheel instead of clicking and dragging within the scroll bar.  

System Tray [Windows Operating Systems]
 Located on the right side of the Windows toolbar. It is the collection of small icons on the opposite side 
of the Start Menu. The volume control and the date & time are default items in the systray and many more can 
be added. Some common icons that get placed in the systray are virus-scan, mouse, and instant messenger icons. 
They usually get put in the systray (whether you like it or not) when their respective programs are installed.
 The nice thing about the systray is that it allows quick and easy access to programs and control settings. 
Most systray icons will open a control panel or program when double-clicked. However, if you install too many 
of them, the area can get so cluttered, you may find it easier to just browse your hard drive and open the pro-
gram.

True Type Fonts
A TrueType font file includes many different kinds of information used by the TrueType rasterizer and the op-
erating system software to ensure that characters display on the computer screen or print out exactly as the font 
designer intended them to. All of the information in a TrueType font is arranged in a series of tables.

Update
 Improvements upon the features of the software that are already available 

Upload
 Places the file from the computer to the memory card

USB (Universal Serial Bus)
 USB is a way for your computer to connect to external devices. It’s fast, easy to use, and allows you to 
use tons of devices all strung together. Most newer computers have one or more USB ports.
 Speed issues aside, one of the big advantages with a USB device is that it can be plugged in while your 
computer is running. When you do, Windows automatically “sees” the device and you’re all set to go. If it’s a 
first time run, Windows simply asks for the device’s setup disk. It takes Plug & Play to the level it’s supposed to 
be at!

Username  
  A username is a name that uniquely identifies someone on a computer system. For example, a computer 
may be setup with multiple accounts, with different usernames for each account. Many websites allow users to 
choose a username so that they can customize their settings or set up an online account. For example, your bank 
may allow you to choose a username for accessing your banking information. You may need to choose a user-
name in order to post messages to a certain message board on the Web. E-mail services, such as Hotmail require 
users to choose a username in order to use the service.
 A username is almost always paired with a password. This username/password combination is referred 
to as a login, and is often required for users to log in to websites. For example, to access your e-mail via the 
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Web, you are required to enter your username and password. Once you have logged in, your username may 
appear on the screen, but your password is kept secret. By keeping their password private, people can create se-
cure accounts for various websites. Most usernames can contain letters and numbers, but no spaces. When you 
choose a username for an e-mail account, the part before the “@” is your username. 

XPM (XPixMap)
 An ASCII image format and a C library. The format defines how to store color images (X Pixmap) in 
a portable and powerful way. The library provides a set of functions to store and retrieve images to and from 
XPM format data, being either files, buffers (files in memory), or data (included files).
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